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Über die X4 BPMS

Digitalisierung braucht eine ganzheitliche Betrachtung, die sich in der einzusetzenden Lösung 
widerspiegeln muss. Als zentrale Plattform unterstützt Sie die X4 BPMS dabei, diese 
Herausforderungen zu lösen. Im Fokus stehen dabei die Modellierung, Implementierung und 
Überwachung Ihrer Geschäftsprozesse. Daher enthält die X4 BPMS alle benötigten Werkzeuge und ist 
mit einer Vielzahl an Schnittstellen und Formaten kompatibel. Mit der X4 BPMS vermeiden Sie 
isolierte Informationssilos, produktivitätshemmende Medienbrüche und beschleunigen die 
Digitalisierung. 

Geschäftsprozesse ohne Programmieraufwand zu realisieren, ermöglicht einem großen 
Anwenderkreis den Einstieg in das Management von Geschäftsprozessen. Das lohnt sich, denn 
Mitarbeiter der Fachabteilung wissen in der Regel am besten, worauf es bei den jeweiligen 
Geschäftsabläufen im Kern ankommt. Setzen Sie daher auf die X4 BPMS als Plattform, deren 
Werkzeuge die Komplexität soweit reduzieren, dass sich auch ohne Programmierkenntnisse 
Geschäftsprozesse analysieren, optimieren, modellieren als auch kontrollieren und dokumentieren 
lassen. Alle Werkzeuge unterstützen eine integrierte, grafische Prozessmodellierung und 
-implementierung und erzeugen Prozesse, die von der X4 BPMS performant ausgeführt werden.

X4 Designer: Prozesse und Regeln grafisch modellieren
X4 Server: Simulation und Ausführung der Prozesse und Regeln
X4 Adapter: Drittsysteme in Prozesse integrieren
X4 Web Apps: Web Apps für Mitarbeiter und Kunden bereitstellen

An wen richtet sich dieses Dokument?
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Dieses Dokument richtet sich an alle Anwender, die mit der X4 BPMS ihre Geschäftsprozesse 
erfassen, modellieren und optimieren möchten. Die X4 BPMS bietet hierfür mit dem X4 Designer den 
international etablierten Standard BPMN 2.0 (Business Process Model and Notation).  Zudem macht 
Sie diese Dokumentation mit den grundlegenden Prinzipien der Modellierung von Geschäftsprozessen 
mit der X4 Suite vertraut und erläutert die Bedienung des X4 Designers und seiner zahlreichen 
Werkzeuge.
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1 Oberfläche

1 Menüleiste Über die Menüleiste können Sie verschiedene Funktionen und 
Editoren des X4 Designers aufrufen.

2 Symbolleiste Über die Symbolleiste können Sie verschiedene Funktionen und 
Anzeigeoptionen aufrufen. Einige Symbole sind nur aktiv, wenn 
die entsprechende Funktion für das ausgewählte oder geöffnete 
Element verfügbar ist, siehe auch Symbolleiste.

3 Sichten Sie können die angezeigten Sichten per Drag&Drop individuell 
anordnen.

4 Perspektiven Über diese Symbole können Sie zwischen den Perspektiven X4 
Designer, Debug und BPMN Designer wechseln.

5 Editoren und 
Zeichnungsfläche

In diesem Bereich werden Prozesse und Dateien zum Anzeigen 
und Bearbeiten in Registerkarten geöffnet.

6 Statusleiste In der Statusleiste werden der verbundene Server, der 
angemeldete Benutzer und die Version der X4 BPMS angezeigt.
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1.1 Symbolleiste
Über die Symbolleiste können Sie verschiedene Funktionen und Anzeigeoptionen aufrufen. Einige 
Symbole sind nur aktiv, wenn die entsprechende Funktion für das ausgewählte oder geöffnete 
Element verfügbar ist.

Connect Verbindung zum Server herstellen

Disconnect Verbindung zum Server trennen

New Neues Element hinzufügen

 Welche Elemente Sie über dieses Symbol hinzufügen können, 
hängt davon ab, in welcher Perspektive und an welcher Stelle der 
Baumstruktur im Repository Sie sich befinden.

Save Änderungen im aktuell geöffneten Fenster speichern

Save all Alle Änderungen speichern

Repository Refresh Server-seitige Aktualisierung durchführen

/
Attach/Detach Debug Debugger mit der Server-Instanz verbinden/Debugger von der 

Server-Instanz lösen

Start Debugging Debugger starten

Undo Letzten Bearbeitungsschritt rückgängig machen

Redo Rückgängig gemachten Schritt wiederherstellen

Cut Auswahl ausschneiden

Copy Auswahl kopieren

Paste Auswahl einfügen

Start Debugging Optionen zur Prozessausführung aufrufen:

Start Debugging: Prozess debuggen (Fehler anzeigen 
und beseitigen)
Start Without Debugging: Prozess direkt ausführen
Debug/Run Options: Run/Debug-Einstellungen im X4 
Designer öffnen
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Suspend Debugging anhalten

Resume Debugging fortsetzen

Stop Debugging Debugging beenden

Step Into Prozess-Schritt ausführen (mit Anzeige der Schritte des 
Subprozesses)

Step Over Prozess-Schritt ausführen (ohne Anzeige der Schritte des 
Subprozesses)

Step Return Aus Subprozess herausspringen

Toggle Breakpoint Breakpoint (Debug-Haltepunkt) zu markiertem Baustein setzen 
oder entfernen

Clear all Breakpoints Alle Breakpoints in diesem Prozess löschen

Quick Watch Quick-Watch-Sicht öffnen, um Platzhalter, dynamische 
Parameter und Kontextvariablen mit ihren Werten während des 
Debuggens zu betrachten

Output Output-Sicht öffnen, um das Ergebnis jedes Prozess-Schrittes 
während des Debuggens zu betrachten

Zoom Out Ansicht verkleinern

Zoom Zoom-Stufe wählen

Zoom In Ansicht vergrößern

Snap to grid Raster einblenden und Bausteine am Raster ausrichten

Show Process Quality Index Process Quality Index einblenden

1.2 Kontextmenü
Kontextmenü für Prozessbausteine 

Wenn Sie im Editor-Bereich des X4 Designers mit der rechten Maustaste auf einen Prozessbaustein 
klicken, stehen Ihnen je nach Bausteinart und Prozesstyp verschiedene Funktionen zur Verfügung:



X4 BPM

© SoftProject GmbH 12

•

•

•

•

Add Component Neue Prozesskomponente hinzufügen
Layout Ausgewählte Prozesskomponenten ausrichten:

Align Horizontal: Komponenten anhand des Mittelwertes 
horizontal ausrichten
Align Vertical: Komponenten anhand des Mittelwertes 
vertikal ausrichten
Distribute Horizontal: Komponenten gleichmäßig 
horizontal verteilen
Distribute Vertical: Komponenten gleichmäßig vertikal 
verteilen

Select All Alle Prozesskomponenten auswählen
Copy Process Diagram to 
Clipboard

Prozessdiagramm zwischenspeichern

Edit Label... Namen der Prozesskomponente bearbeiten
Undo ... Rückgängig machen

Redo ... Letzten Schritt wiederherstellen

Copy Markierten Prozessbaustein kopieren

Cut Markierten Prozessbaustein ausschneiden

Set ... document Markierten Baustein durch ein anderes Element im Repository 
austauschen

Edit ... Markierten Baustein/Datei bearbeiten (nur Modul-Bausteine und 
Dokumente)

Toggle Breakpoint Debug-Haltepunkt setzen

Delete Prozessbaustein aus dem Prozessdiagramm entfernen

Validate Subprozess auf Gültigkeit prüfen (nur bei Subprozessen)
Preview Prozessbaustein in separatem Editor öffnen (nur bei Modul-

Bausteinen und Dokumenten)
Show input schema Input-Schema des Subprozesses anzeigen (falls vorhanden)
Show output schema Output-Schema des Subprozesses anzeigen (falls vorhanden)
Select in Repository 
Navigator

Prozessbaustein im Repository Navigator zeigen

View Call Hierarchy Verwendungsnachweis für den markierten Prozessbaustein anzeigen

Refresh Prozessbaustein neu aus dem Repository laden (nur bei Modul-
Bausteinen und Dokumenten)

Bring to Front Symbol in den Vordergrund des Diagramms setzen
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Bring Forward Symbol im Diagramm eine Ebene nach vorne setzen

Send Backward Symbol im Diagramm eine Ebene nach hinten setzen

Send to Back Symbol in den Hintergrund des Diagramms setzen

Properties Eigenschaften des Prozessbausteins in der Properties-Sicht anzeigen

Schema Declaration... Schema-Deklaration für den Prozess hinterlegen

Kontextmenü in der Projects-Sicht

Das Kontextmenü können Sie per Rechtsklick auf ein Element in der Projects-Sicht aufrufen.

New Neue Elemente (Prozesse, Ordner, Adapter etc.) im Repository 
anlegen

Open / Open With Markiertes Element (Prozess, Ordner, Adapter etc.) mit dem 
Standard-Editor oder einem bestimmten Editor öffnen

Save As Template Markiertes Element als Vorlage speichern
Copy Full Path to Clipboard /
Copy XStore URL to 
Clipboard

Pfad zur markierten Datei in die Zwischenablage kopieren (als 
Ordnerpfad oder als xstore://-URL)

Cut, Copy und Paste Markiertes Elemente ausschneiden, kopieren oder einfügen
Delete Markiertes Element aus dem Repository löschen (der Löschvorgang 

kann nicht rückgängig gemacht werden)
Rename/Refactor Element (und falls gewünscht dessen Referenzen) umbenennen
Exclude from Project Ressource aus dem Projekt ausschließen

Include to Project Ausgeschlossene Ressource wieder in das Projekt aufnehmen
Repair References Pfade von Repository-Ressourcen in Prozessdiagrammen reparieren
Validate Prozess auf Gültigkeit prüfen
View Call Hierarchy Anzeigen, in welchen Prozessen dieses Element verwendet wird
Start Without Debugging Prozess direkt ausführen
Import Ressource ins Repository importieren
Export Projekt oder Ressource exportieren
Clean-Up Project Nicht verwendete Dateien auswählen und aus dem Repository 

löschen

•

•

Die Datei wird im Dateisystem beibehalten, ist jedoch 
nicht mehr Bestandteil des Projektes und wird ausgegraut 
dargestellt.
Die üblichen Operationen wie Öffnen, Bearbeiten, 
Kopieren, Löschen usw. können für ausgeschlossene 
Dateien nicht ausgeführt werden.


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1.3 Perspektiven
Eine Perspektive ist eine festgelegte Anordnung von Sichten und dem Editorbereich. Sie können per 
Drag&Drop individuell anordnen.

X4 Designer Die X4 Designer-Perspektive ist die Standardansicht.

Debug Die Debug-Perspektive ist eine optimierte Ansicht für das Debugging von 
Geschäftsprozessen und technischen Prozessen.

BPMN 
Designer

Die BPMN Designer-Perspektive ist eine optimierte Ansicht für die Modellierung von 
Geschäftsprozessen.

1.3.1 Perspektive wechseln
Im X4 Designer können Sie zwischen Perspektiven wechseln. Die Anordnung der Sichten bleibt dabei 
erhalten.

Um die Perspektive zu wechseln, klicken Sie im oberen rechten Bildschirmbereich auf das 
Symbol der gewünschten Perspektive.

1.3.2 Perspektive zurücksetzen
Um eine Perspektive zurückzusetzen, gehen Sie wie folgt vor:

Wechseln Sie in die Perspektive.
Wählen Sie in der Menüleiste Window > Reset Window Layout.

1.4 Sichten
Projects In der Sicht Projects wird eine Baumstruktur des verbundenen Repositorys mit 

verschiedenen Elementen wie Projekten, Ordnern und Dateien angezeigt. Sie können 
das Kontextmenü aufrufen, indem Sie mit der rechten Maustaste auf ein Element 
klicken. Abhängig davon, an welcher Stelle in der Baumstruktur Sie sich befinden, 
ändern sich die Optionen im Kontextmenü.

Über das Textfeld Filter über dem Projektbaum können Sie nach Dateien innerhalb 
des verbundenen Repositorys suchen. Platzhalter wie * oder ? sind nicht möglich.

Über die Symbolleiste der Sicht Projects können Sie die folgenden Aktionen 
ausführen:

 Jump from active Editor to Repository Navigator: Geöffnete Datei im Editor 
im Repository Navigator markieren

 Show or hide all files: Inhalt des Dateisystems einblenden und ausblenden. 
Aus dem Projekt ausgeschlossene Dateien werden dabei ausgegraut dargestellt.
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Apps In der Sicht Apps werden alle X4 Apps angezeigt, die zum Bündeln von Projekten 
verwendet werden.

Properties In der Sicht Properties können Sie die Eigenschaften von markierten 
Prozessbausteinen und geöffneten Prozessen anzeigen und bearbeiten.

In der linken Spalte befinden sich die Eigenschaften, in der rechten Spalte die 
zugehörigen Werte.
Für jeden Prozess kann ein Titel sowie eine Beschreibung hinterlegt werden. 
Diese Angaben werden in der erzeugten Dokumentation angezeigt.
Um die Eigenschaften eines geöffneten Prozesses zu bearbeiten, klicken Sie auf 
einen leeren Bereich auf der Zeichnungsfläche.

Standardmäßig werden die gebräuchlichsten Eigenschaften angezeigt. Über die 
Symbolleiste der Sicht Properties können Sie jedoch zusätzliche Einstellungen 
vornehmen:

 Pin to Selection: Angezeigte Eigenschaften in der Sicht Properties anheften

 Show Categories: Eigenschaften nach Kategorien geordnet anzeigen

 Show Advanced Properties: Erweiterte Eigenschaften anzeigen

 Restore Default Value: Auf Standardwerte zurücksetzen

View Menu: Zusatzoptionen öffnen
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Run/Debug 
Console

Wird ein Prozess auf Fehler überprüft bzw. simuliert, werden in der Sicht Run/Debug 
Console zu jedem ausgeführten Prozess-Schritt Debug-Informationen angezeigt. 
Fehlermeldungen werden rot hervorgehoben, erfolgreiche Statusmeldungen grün.

Wenn ein Prozess-Schritt ein Zwischenergebnis ausgibt, wird dieses während des 
Debuggens in einer temporären Datei gespeichert, die Sie über den entsprechenden 
Verweis ansehen können (z. B. file://1376054979039/). 

 Sie können die Sicht Run/Debug Console über das Menü View > Run/Debug 
Console aufrufen.

file://1376054979039/
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Output In der Sicht Output können Sie die Ergebnisse jedes einzelnen Debug-Schrittes 
einsehen.

Über die Symbolleiste können Sie außerdem die folgenden Aktionen ausführen:

Find content: Daten in der Sicht Output finden

Copy all content: Alle Daten in der Sicht Output in die Zwischenablage 
kopieren

Copy selected content: Ausgewählte Daten in der Sicht Output in die 
Zwischenablage kopieren

 Save content of output view: Daten aus der Sicht Output speichern
 Format the content of the output view: Daten aus der Sicht Output

formatieren

 Sie können die Sicht Output während des Debuggens über das Menü Debug > 
Output oder über das Output-Icon  in der Symbolleiste aufrufen.

Enthält das Ergebnis Inhalte, die größer als 1 MB sind, wird eine Warnung 
angezeigt, und Sie können das Ergebnis über eine Schaltfläche 
herunterladen.
Große Datenmengen können sich negativ auf die Leistungsfähigkeit des X4 
Designers auswirken. 


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X4 Server 
Log

In der Sicht X4 Server Log können Sie den Server-Status und insbesondere Fehler im 
X4-Server-Log aus dem X4 Designer heraus verfolgen.

 Sie können die Sicht X4 Server Log über das Menü View > X4 Server Log aufrufen.

Call 
Hierarchy

In der Sicht Call Hierarchy können Sie für jeden Prozess und Prozessbaustein im 
Repository anzeigen, von welchen Repository-Elementen diese verwendet werden.

Wenn Sie mit der rechten Maustaste auf ein Element im Repository Navigator 
klicken, wird ein Kontextmenü aufgerufen. Mit View Call Hierarchy wird 
anschließend eine Auflistung aller Repository-Elemente angezeigt, die mindestens 
eine Referenz auf das markierte Element enthalten.
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Error Log In der Sicht Error Log können Sie im X4 Designer aufgetretene Fehler einsehen.

Über die Symbolleiste können Sie außerdem die folgenden Aktionen ausführen:

 Export Log: Error Log exportieren und als .log-Datei speichern
 Import Log: Error Log (.log) importieren
 Clear Log Viewer: Error Log bereinigen 
 Delete Log: Error Log unwiderruflich löschen
 Open Log: Log-Datei (.log) im X4 Designer öffnen
 Restore Log: Error Log wiederherstellen
View Menu: Zusatzoptionen öffnen

 Sie können die Sicht Error Log über das Menü View > Error Log aufrufen.

Problems In der Sicht Problems werden alle Fehler und Warnungen aufgelistet. Sie können die 
Liste der Probleme über das Filtersymbol anpassen.

Debug 
sessions

In der Sicht Debug sessions werden alle aktiven Debug-Sessions aufgelistet. Indem 
Sie in der Sicht Debug sessions auf einen Prozess doppelklicken, wechseln Sie in die 
zugehörige Debug-Session.

Aktive Debug-Sessions sind grau markiert. Mit dem Server verbundene, neue Debug-
Sessions sind orange markiert.

Breakpoint
s

In der Sicht Breakpoints werden alle gesetzten Breakspoints aufgelistet. Sie können 
Breakpoints aktivieren, deaktivieren und löschen. Außerdem können Sie alle 
Breakpoints überspringen, ohne die Breakpoints zu löschen.
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Quick 
Watch

In der Sicht Quick Watch können Sie Platzhalter, dynamische Parameter und 
Kontextvariablen mit ihren Werten während des Debuggens betrachten.

Ausgewählte Variablen werden nach jedem Debug-Schritt aktualisiert.

 Sie können die Sicht Quick Watch während des Debuggens über das Menü Debug > 
Quick Watch oder über das Quick-Watch-Symbol  in der Symbolleiste aufrufen.

Outline In der Sicht Outline wird das vollständige Prozessdiagramm als Abbildung angezeigt. 
Sie können auf einzelne Bereiche in der Abbildung klicken und so mühelos durch den 
Prozess navigieren, selbst wenn die Abbildung größer ist als das Designer-Fenster.

 Sie können die Sicht Outline über das Menü View > Outline aufrufen.

Base64 Zeichenketten Base64-kodieren oder dekodieren

Digest Hash-Wert für Zeichenketten erzeugen

Regex Regulären Ausdruck (Regex) auf eine Zeichenkette anwenden, um den Ausdruck zu 
testen oder um die Zeichenkette gemäß einem Muster direkt zu ersetzen

URLCodec Zeichenketten URL-kodieren oder dekodieren

1.4.1 Sichten öffnen

Wählen Sie in der Menüleiste im Menü View die gewünschte Sicht.

Enthält das Ergebnis Inhalte, die größer als 1 MB sind, wird eine Warnung 
angezeigt, und Sie können das Ergebnis über eine Schaltfläche 
herunterladen.
Große Datenmengen können sich negativ auf die Leistungsfähigkeit des X4 
Designers auswirken. 



In der Perspektive BPMN Designer können keine weiteren Sichten geöffnet werden, da alle 
relevanten Sichten standardmäßig geöffnet sind.


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1.5 Editoren
Im X4 Designer werden Prozesse und Dateien zum Anzeigen und Bearbeiten in Registerkarten 
geöffnet. Der verwendete Editor ist abhängig vom geöffneten Dateityp.

Editor Verwendung Beschreibung
BPMN Editor .bpm

.pld

Mit dem BPMN Editor können Sie 
Geschäftsprozesse gemäß dem 
Notationsstandard BPMN 2.0 modellieren.

Process Editor .wrf Mit dem Process Editor können Sie technische 
Prozesse grafisch modellieren.

Mapping Editor .xsl

.rep

Mit dem Mapping Editor können Sie XSL-
Mappings in einer grafischen Ansicht erstellen 
und bearbeiten.

XML Editor .xml

.xhtml

Mit dem XML Editor können Sie wohlgeformte 
XML-Dokumente erstellen und bearbeiten.

XSD Editor .xsd

JSON Editor .json Mit dem JSON Editor können Sie JSON-
Dokumente direkt im X4 Designer bearbeiten. 

Datenbank-Editor .stm Mit dem Datenbank-Editor können Sie SQL-
Abfragen für Bausteine einer 
Datenbankverbindung definieren, um Daten aus 
einer relationalen Datenbank abzufragen.

1.5.1 BPMN Editor
Mit dem BPMN Editor können Sie Geschäftsprozesse gemäß dem Notationsstandard BPMN 
2.0 modellieren. Der Editor entspricht in Aufbau und Bedienweise in weiten Teilen dem Process 
Editor im X4 Designer, unterscheidet sich jedoch im Hinblick auf die Prozessbausteine und Symbole 
im Prozessdiagramm. Mit dem BPMN Editor werden die modellierten Geschäftsprozesse direkt mit 
den technischen Prozessen verknüpft. Das heißt: Sie können Ihre fachlichen und technischen 
Prozesse modellieren und über den X4 Server testen und ausführen, ohne die Entwicklungsumgebung 
zu wechseln.
Da auch nicht-automatisierbare Aktionen – etwa Arbeitsabläufe von Menschen – in 
Geschäftsprozesse eingebunden werden können, lassen sich Geschäftsprozesse nicht 
notwendigerweise auf dem X4 Server ausführen.

Im Free-flow-Modus besteht zusätzlich die Möglichkeit, den BPMN Editor als reines BPMN-
Zeichenwerkzeug mit einer erweiterte BPMN-Palette zu verwenden, bei der die Funktion Run/
Debug deaktiviert ist.


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1.5.2 Datenbank-Editor
Mit dem Datenbank-Editor können Sie SQL-Abfragen für Bausteine einer Datenbankverbindung 
definieren, um Daten aus einer relationalen Datenbank abzufragen. Durch die logische Trennung der 
Prozessbausteine SQL-Anweisung und Datenbankverbindung lassen sich diese Prozessbausteine 
im X4 Designer flexibel einsetzen und mehrfach verwenden.

Aufbau des Datenbank-Editors

Der Datenbank-Editor besteht aus den folgenden Bereichen:

Statement Editor: In diesem Bereich können Sie eine Verbindung zu einer Datenbank aufbauen 
und die Struktur der verbundenen Datenbank anzeigen. Mit dieser Struktur können 
anschließend SQL-Statements für die Datenbank erstellt werden.
Mapping Editor: In diesem Bereich können Sie für das im Statement Editor zuvor erstellte 
Statement ein Mapping von Elementen eines Input-XML-Dokuments auf die Named Parameter 
des Statements definieren. Aus diesem Mapping können Sie anschließend ein XSL-Mapping 
erstellen, das mit einem passenden Input-XML-Dokument eine dynamisch erzeugte Eingabe für 
den JDBC Connector erzeugt.

1.5.2.1 Statement Editor

Der Statement Editor ist in folgende Bereiche unterteilt:

Um den Datenbank-Editor aufzurufen, legen Sie eine neue SQL-Statement-Datei (.stm) an, 
oder öffnen Sie eine bereits vorhandene SQL-Statement-Datei.


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Connec
tion-
Bereich

In diesem Bereich können Sie über einen JDBC Connector eine Verbindung zu einer 
Datenbank aufbauen.

JDBC Connector: xstore-URL zu einem JDBC Connector

Connect: Mit der Datenbank verbinden
 Unter Status wird der Verbindungstatus angezeigt.

Execute Statement: Statement ausführen

Databa
se-
Bereich

 In diesem Bereich wird nach dem Verbindungsaufbau die Struktur der Datenbank 
angezeigt. Für die Darstellung der Struktur werden die folgenden Symbole verwendet:

 Datenbankschema
 Datenbanktabelle
 Primärschlüssel
 Primärschlüssel/Fremdschlüssel
 Fremdschlüssel

•

•

Um eine Verbindung aufbauen zu können, muss der Adapter innerhalb des 
Parameters JndiName einen gültigen JNDI-Namen enthalten.
In der Dropdown-Liste werden die letzten acht verbundenen URLs zur 
Auswahl angeboten.


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Statem
ent-
Bereich

In diesem Bereich können Sie über das Kontextmenü verschiedene Statements für die 
verbundene Datenbank anlegen:

New Named Prepared Statement: Im Statements Root ein neues Named Prepared 
Statement anlegen
Edit Named Prepared Statement: Named Prepared Statement bearbeiten
New RowSet: Neues RowSet anlegen.

 Innerhalb eines Named Prepared Statement kann lediglich ein RowSet existieren. 
Dieses wird beim Anlegen des Named Prepared Statement automatisch mit angelegt.
Ein neues RowSet kann nur angelegt werden, wenn das bestehende RowSet gelöscht 
wurde.

New Row: Neue Zeile innerhalb eines RowSet hinzufügen

New Named Parameter Value: Einen neuen Named Parameter-Wert innerhalb einer 
Zeile hinzufügen

Edit Named Parameter: Named Parameter bearbeiten

New SELECT Statement: Ein neues SELECT-Statement anlegen

Edit SELECT: SELECT-Befehl bearbeiten

Edit FROM: FROM-Befehl innerhalb eines SELECT-Statements bearbeiten

New INSERT Statement: Ein neues INSERT-Statement anlegen

Edit INTO: INTO-Befehl bearbeiten

New VALUE Entry: Neuen Eintrag unter VALUE anlegen

Edit VALUE: Wert eines VALUE-Eintrags bearbeiten 

New UPDATE Statement: Ein neues UPDATE-Statement anlegen

Edit UPDATE: UPDATE-Befehl bearbeiten

New SET Entry: Neuen Eintrag unter SET anlegen

Edit SET Entry: Eintrag unter SET bearbeiten

New DELETE Statement: Ein neues DELETE-Statement anlegen

Edit FROM: FROM-Befehl bearbeiten

Edit WHERE: WHERE-Bedingung bearbeiten 

New Column: Neue Spalte innerhalb eines INSERT- oder SELECT-Befehls einfügen

New Table: Neue Tabelle innerhalb eines UPDATE- oder SELECT-Befehls einfügen

Delete: Element löschen

Drag&Drop-Aktionen

Im Statement-Bereich können Sie die folgenden Drag&Drop-Aktionen ausführen:

Weitere Informationen zum Anlegen und Bearbeiten von Statements finden Sie im 
Abschnitt Statement für eine verbundene Datenbank erstellen.


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SQL-
Statement

Datenbank-
Element

Statement-
Element

Aktion

SELECT Column SELECT Die auszuwählende Spalte hinzufügen

 Steht die Tabelle der Spalte noch 
nicht im FROM, wird diese hinzugefügt.

Table FROM Tabelle hinzufügen, aus der ausgewählt 
werden soll

UPDATE Column SET Entry Spalte als Eintrag setzen

 Steht die Tabelle der 
entsprechenden Spalte noch nicht im U
PDATE, wird diese hinzugefügt.

Table UPDATE Die zu aktualisierende Tabelle setzen
INSERT Table INTO Tabelle setzen, in die geschrieben 

werden soll

 Ist bereits eine Tabelle vorhanden, 
wird diese ersetzt. Dabei werden auch 
bereits gesetzte Spalten (Columns) 
gelöscht.

Column INTO Spalte setzen, in die geschrieben 
werden soll

 Dies ist nur möglich, wenn die 
Spalte aus der gesetzten Tabelle 
stammt.

DELETE Table FROM Die zu löschende Tabelle setzen

 Ist bereits eine Tabelle vorhanden, 
wird diese ersetzt.

1.5.2.2 Mapping Editor

Mit dem Mapping Editor können Sie für die zuvor im Statement Editor angelegten Statements per 
Drag&Dropp Mappings von einem Input-XML-Dokument auf die Named Parameters der Statements 
konfigurieren und anschließend erstellen. Diese Mappings erzeugen mit einem passenden Input-XML-
Dokument eine dynamisch erzeugte Eingabe für den JDBC Connector.

Der Mapping Editor ist in folgende Bereiche unterteilt:
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Quelldok
ument-
Bereich

Auf der linken Seite befindet sich in der Quelldokument-Bereich. In diesem Bereich 
können Sie die Input-XML-Datei per Drag&Drop ablegen und anzeigen.

Über das Kontextmenü können Sie den gewählten Knoten wie folgt bearbeiten:

Collapse: Knoten mit aufgeklappten Unterelementen zuklappen
Expand: Unterelemente des Knotens aufklappen
Remove Input: Input-XML-Dokument entfernen

Verknüp
fungsbe
reich

In der mittleren Spalte befindet sich der Verknüpfungsbereich. In diesem Bereich werden 
die xsl:value-of-Verknüpfungen zwischen dem Element aus dem Quelldokument und 
dem Named Parameter im Statement als Linien visualisiert.

Stateme
nts-
Bereich

Auf der rechten Seite befindet sich der Statements-Bereich. In diesem Bereich wird die 
gesamte Struktur der Statement-Datei angezeigt. Dabei können Mappings vom Input-XML 
auf die Kind-Elemente eines Row-Elements erstellt werden.

1.5.3 JSON Editor
Mit dem JSON Editor können Sie JSON-Dokumente direkt im X4 Designer bearbeiten. 

In der Sicht Outline wird die Struktur des geöffneten JSON-Dokuments angezeigt. Zudem können Sie 
über das Kontextmenü Quick Outline oder über die Tastenkombination STRG+O die Sicht Quick Outline
öffnen, um innerhalb des JSON-Dokuments nach Schlüsseln und Werten zu suchen.

Tastenkombinationen

STRG+O Sicht Quick Outline öffnen
STRG+Umschalttaste+F JSON-Code formatieren

Um den JSON Editor zu starten, legen Sie entweder ein neues JSON-Dokument an oder 
öffnen ein bereits vorhandenes Dokument. 


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1.5.4 Mapping Editor
Mit dem Mapping Editor können Sie XSL-Mappings in einer grafischen Ansicht erstellen und 
bearbeiten. Eine XML-Datenstruktur kann hier mithilfe von XSLT in eine andere XML-Datenstruktur 
oder in ein XSL-FO-Dokument transformiert werden. Der Mapping Editor unterstützt Sie beim 
Erstellen eines XSL-Mappings durch eine grafische Oberfläche und durch eine automatische 
Gültigkeitsprüfung des Stylesheets sowie der XPath-Ausdrücke.

Bei einem XSL-Mapping sind drei Dokumente involviert:

XML-Quelldokument (oder ein XML-Schema mit der Strukturinformation)
XSLT-Stylesheet (dieses wird im Mapping Editor erstellt)
XML-Ausgabedokument

Aufbau des Mapping Editors

Der Mapping Editor ist in folgende Bereiche unterteilt:

Die Formatierung des JSON-Codes sowie die Farben zur Syntaxhervorhebung können Sie 
unter Tools > Options > JSON Editor ändern. Siehe auch JSON-Editor konfigurieren.



Um den Mapping Editor zu starten, legen Sie entweder ein neues Mapping an oder öffnen ein 
bereits vorhandenes XSLT-Mapping. 


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1 Quelldokument-Bereich In diesem Bereich wird das zu transformierende Quelldokument 
oder eine XML-Schema-Datei (.xsd) angezeigt.

Über das Kontextmenü können Sie den gewählten Knoten wie 
folgt bearbeiten:

Copy XPath for this element to Clipboard: XPath-
Ausdruck zum entsprechenden Element in die 
Zwischenablage kopieren und an anderer 
Stelle verwenden
Assign Input: Input-XML-Dokument zuweisen
Remove Input: Input-XML-Dokument entfernen

2 Verknüpfungsbereich In diesem Bereich werden die Verknüpfungen zwischen Knoten 
im Quelldokument und XSL-Stylesheet als verschiedenfarbige 
Linien visualisiert.

Unter Tastenkombinationen im Mapping Editor finden 
Sie nützliche Tastenkombinationen für die Arbeit mit 
XSL-Stylesheets in der grafischen Ansicht des X4 
Mapping Editors.


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3 Stylesheet-Bereich In diesem Bereich bearbeiten Sie den Hauptbestandteil eines 
Mappings, das XSL-Stylesheet. Das Stylesheet wird in einer 
Baumstruktur angezeigt und bietet über das Kontextmenü 
Zusatzfunktionen für die XSL-Bearbeitung.

Die verschiedenen Bestandteile des XSL-Stylesheets werden in 
der Baumansicht mit Symbolen und farblichen Hervorhebungen 
dargestellt:

Knoten mit XSL-Anweisungen sind durch eine braune 
Schriftfarbe und ein entsprechendes Symbol 
gekennzeichnet, z. B.  .

Knoten mit einem XPath-Ausdruck sind durch ein 
entsprechendes XPath-Symbol ( ) gekennzeichnet. Um den 
XPath-Ausdruck zu bearbeiten, klicken Sie auf dieses 
Symbol.

Virtuelle Knoten (aus der Quellstruktur übernommene, aber 
noch nicht im Stylesheet explizit vorhandene Knoten) werden 
grau dargestellt.

Über das Kontextmenü können Sie im Stylesheet-Bereich den 
gewählten Knoten wie folgt bearbeiten:

Edit XSL Element: XSL-Element bearbeiten
Rename: Knoten umbenennen
Element: Element einfügen
Attribute: Attribut einfügen
Edit: (bei Processing Instructions, Namespace-
Deklarationen): Knoteninhalt bearbeiten
XSL Element: XSL-Element einfügen

as Child: als Kind-Knoten
Before: als Knoten vor dem markierten Knoten
After: als Knoten hinter dem markierten Knoten

Add other nodes: Andere Knoten einfügen (Namespace, Text, 
Comment, Processing Instruction) 
Add here: (nur bei virtuellen Knoten): Virtuellen Knoten in 
tatsächlichen Knoten umwandeln
Add X4 Processing Instructions: X4-spezifische Processing 
Instructions hinzufügen, um Parameter dynamisch zu setzen

Condition State für Statusinformationen
Log Info für Log-Nachrichten
Dynamic Parameter zum Setzen von dynamischen 
Werten
No Result für leere Mapping-Ausgaben

Add X4 Placeholder: X4-spezifische Platzhalter einfügen
Add Parent: Eltern-Element (übergeordnetes Element) 
einfügen
Cut/Copy/Paste: Auswahl ausschneiden, kopieren und 
einfügen 
Delete: Knoten löschen
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Expand/Collapse: Unterelemente des Knotens aufklappen 
bzw. zuklappen
Assign Virtual Nodes: Virtuellen Knoten aus einem XML-
Dokument einfügen 
Remove Virtual Node: Eingefügten virtuellen Knoten 
entfernen

4 Source- und Design-Ansicht Der Mapping Editor verfügt über zwei Ansichten, zwischen denen 
Sie über zwei Registerkarten wechseln können:

Design: In der dreispaltigen Design-Ansicht wird das 
XSLT-Stylesheet als Baum dargestellt. Hier können Sie die 
Knoten des Quelldokuments den Knoten im XSLT-
Stylesheet grafisch zuordnen.

Source: In dieser Quellcode-Ansicht können Sie das XSLT-
Stylesheet direkt im XML-Editor bearbeiten.

5 Output Das Ergebnis von lokal ausgeführten XSL-Mappings wird in der 
Sicht Output angezeigt.

Außerdem können Sie über die Symbolleiste die folgenden 
Aktionen ausführen:

 Save content of output view: Daten aus der Sicht Output
speichern

 Format the content of the output view: Daten aus der 
Sicht Output formatieren

Mit dem XSL Element Creation Wizard können Sie 
einfach und schnell XSL-Mappings erstellen. Der Wizard 
bietet neben der kompletten Palette an XSLT 2.0-
Elementen auch die Möglichkeit, die Mappings 
bequem über das Kontextmenü anzulegen.

Über den Wizard lässt sich festlegen, ob das neue 
Element vor oder nach dem ausgewählten Element oder 
als Kind des ausgewählten Elements angelegt werden 
soll. Funktionen wie Autovervollständigung oder die 
Anzeige aller verfügbaren und erlaubten XSL-Elemente 
ermöglichen schnelleres Arbeiten.

Bei Attributen, die mehrere Optionen zur Auswahl haben, 
wird eine Liste mit den verfügbaren 
Werten bereitgestellt. 



Zudem können die Attribute des XSL-Elements gesetzt 
bzw. nach dem Anlegen bearbeitet werden. Zwingend 
erforderliche Attribute werden dabei automatisch 
übernommen, optionale Attribute können je nach Bedarf 
ausgewählt und befüllt werden. 
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6 Run Transformation Über Run Transformation wird das XSL-Mapping lokal 
ausgeführt, und das Transformationsergebnis wird in der Sicht 
Output (5) angezeigt.

1.5.4.1 Tastenkombinationen im Mapping Editor

Hier finden Sie nützliche Tastenkombinationen für die Arbeit mit XSL-Stylesheets in der grafischen 
Ansicht des X4 Mapping Editors.

Aktionen per Drag&Drop

Werte mit dem Zielknoten 
verknüpfen mit xsl:value-
of

Knoten im Quelldokument per Drag&Drop auf den Zielknoten ziehen

Mehrere Werte im 
Zielknoten verknüpfen mit 
xsl:value-of

Alt-Taste drücken und alle gewünschten Knoten im Quelldokument auf 
den Zielknoten ziehen

Ergebnis: im select-Attribut des erzeugten xsl:value-of-Elements 
werden alle verknüpften Elemente nacheinander hinterlegt und 
können anschließend mit einer XPath-Funktion wie concat() oder 
logischen Operatoren verknüpft werden.

Beispiel: <xsl:value-of select="Element1 Element2">

Knoten kopieren mit 
xsl:copy-of

Strg-Taste drücken und Knoten im Quelldokument auf den Zielknoten 
ziehen

For-Each-Schleife zu 
Knoten erstellen mit 
xsl:for-each

Shift-Taste drücken und Knoten im Quelldokument auf den Zielknoten 
ziehen

Funktion Tastenkombination
Basisfunktionen Element bearbeiten Enter

XSL-Transformation ausführen F9

Element einfügen Einfg 

Attribut einfügen Alt+Einfg 

Text einfügen Strg+Einfg 

Umschließendes Eltern-Element einfügen Strg+Shift+Einfg

Element umbenennen Alt+Shift+R

Markierten Knoten entfernen Entf
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Code formatieren/einrücken (in der Source-Ansicht) Strg+Shift+F

Knoten kopieren Markierten Knoten als vorangehenden Knoten einfügen Strg+Alt+Nach 
oben

Markierten Knoten als nachfolgenden Knoten einfügen Strg+Alt+Nach 
unten

Markierten Knoten als vorangehenden Eltern-Knoten 
einfügen

Strg+Alt+Nach 
links

Knoten 
verschieben

Markierten Knoten als vorangehenden Knoten 
verschieben

Alt+Nach oben

Markierten Knoten als nächsten Knoten verschieben Alt+Nach unten

Markierten Knoten als vorangehenden Eltern-Knoten 
verschieben

Alt+Shift+Nach 
links

Im Stylesheet-
Baum navigieren

Zum Eltern-Element wechseln Strg+Shift+Nach 
links

Zum nächsten Geschwister-Knoten wechseln Strg+Shift+Nach 
unten

Zum vorangehenden Element wechseln Strg+Shift+Nach 
oben

Verbundene Knoten in Quelldokument-Bereich und 
Stylesheet-Bereich markieren

Shift+Einfg

Letzte Markierung wiederherstellen Alt+Shift+Nach 
unten

1.5.5 Process Editor
Mit dem Process Editor können Sie technische Prozesse grafisch modellieren. Außerdem können Sie 
für jeden technischen Prozess und jedem einzelnen Prozessbaustein festlegen, wie diese ausgeführt 
werden sollen.

Mit dem Process Editor können Sie unter anderem:

Verbindungen zwischen verschiedenen Backend-Systemen herstellen,
Daten in Echtzeit transformieren,
Geschäftsregeln im modellierten Prozess implementieren und
modellierte Prozesse debuggen und auf dem X4 Server ausführen

1.5.5.1 Process Quality Index

Der Process Quality Index ist ein experimentelles Feature. Die Funktionalität ist derzeit noch 
eingeschränkt und wird fortwährend weiterentwickelt.


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Der Prozess Quality Index ist ein grafisches Hilfswerkzeug, das angibt, wie qualitativ hochwertig ein 
ESB-Prozess im Hinblick auf Kriterien wie die Einhaltung von Standards und die Übersichtlichkeit 
modelliert wurde.

Gewichtung der Kriterien

Kriterien Bedingung Gewichtung
Anzahl der Elemente 100% →  < 15 Elemente

 75% →   < 20 Elemente

 50% →   < 25 Elemente

 25% →   < 30 Elemente

   0% → >= 30 Elemente

45%

Anzahl der Stopp-Elemente 100% →   < 3 Elemente

 75% →   < 4 Elemente

 50% →   < 5 Elemente

 25% →   < 6 Elemente

   0% → >= 6 Elemente

15%

Labels der Elemente sind nicht leer wahr → 100%

falsch → 0%

10%

Prozesstitel wurde gesetzt (nicht Name der 
Prozessdatei)

wahr → 100%

falsch → 0%

5%

Labels der Elemente wurden angepasst 
(nicht Dateiname)

wahr → 100%

falsch → 0%

5%
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Kriterien Bedingung Gewichtung
Keine Elemente auf der rechten Seite von 
Stopp-Elementen

wahr → 100%

falsch → 0%

5%

Keine Elemente auf der linken Seite von 
Start-Elementen

wahr → 100%

falsch → 0%

5%

Keine überlappenden Elemente wahr → 100%

falsch → 0%

5%

Flow Direction Index 5%
Maximum 100%

1.5.5.2 Tastenkombinationen im Process Editor

Hier finden Sie nützliche Tastenkombinationen für die Arbeit mit dem Process Editors.
Funktion Tastenkombination oder Aktion

Prozess 
ausführen und 
debuggen

Prozess ausführen F9

Prozess auf Fehler prüfen (und ggf. aktiven 
Debugging-Vorgang abbrechen)

F4

Beim Debuggen Einzelschritt ausführen 
und anzeigen (auch in Subprozessen)

F5

Beim Debuggen Prozess-Schritt ausführen 
(ohne Anzeige des Schritte des 
Subprozesses)

F6

Beim Debuggen aus Subprozess 
herausspringen

F7

Debugging anhalten Strg+F8

Debugging fortsetzen F8
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Debugging abbrechen Strg+F2

Prozessbaustei
ne und 
Übergänge 
einfügen

Prozessbaustein zwischen zwei 
verbundenen Bausteinen aus dem 
Repository einfügen

Datei per Drag&Drop aus dem 
Repository auf den Übergang ziehen. 
Wenn die Linie des Übergangs dick 
wird, Maustaste loslassen.

Prozessbaustein von der Übergangslinie 
herunterziehen

Alt-Taste drücken und 
Prozessbaustein auf der 
Zeichnungsfläche verschieben

Prozessbaustein entfernen und 
Übergangslinie behalten

Alt+Entf

Prozessbaustein durch eine Datei aus dem 
Repository ersetzen

Datei per Drag&Drop aus dem 
Repository auf den zu ersetzenden 
Prozessbaustein ziehen

Prozessbaustein hinter einem 
unverbundenen Baustein einfügen und 
dabei automatisch einen Übergang 
herstellen

Unverbundenen Prozessbaustein 
markieren, Shift-Taste drücken und 
die Datei aus dem Repository hinter 
den markierten Prozessbaustein ziehen

Elemente 
bearbeiten

Alles auf der Zeichnungsfläche auswählen Strg+A

Prozessbaustein ausschneiden Strg+X

Prozessbaustein kopieren Strg+C

Prozessbaustein einfügen Strg+V

Prozessbaustein entfernen Entf

Bearbeitungsschritt rückgängig machen Strg+Z

Bearbeitungsschritt wiederherstellen Strg+Y

Prozessbaustein bearbeiten Auf Symbol doppelklicken
Editor schließen Strg+W

Bearbeitetes Element speichern Strg+S

Datei im Repository umbenennen F2

Datei im Repository verschieben Datei per Drag&Drop in den Ordner 
ziehen

Neu laden F5

Ansicht 
bearbeiten

Prozessdiagramm vergrößern (zoomen) Strg++

Prozessdiagramm verkleinern Strg+-

1.5.6 XML-Editor
Mit dem XML Editor können Sie wohlgeformte XML-Dokumente erstellen und bearbeiten.

Aufbau des XML-Editors

Um den XML Editor zu starten, legen Sie entweder ein neues XML-Dokument an oder öffnen 
ein bereits vorhandenes Dokument. 


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Zum Bearbeiten von XML-Dokumenten stehen zwei Sichten zur Verfügung: die Sicht Design un
d die Sicht Source. Über die Registerkarten am unteren Rand des Editors können Sie zwischen 
den Sichten wechseln.

Design In der Sicht Design wird die Baumstruktur des geöffneten XML-Dokuments tabellarisch 
dargestellt. In der linken Spalte befinden sich die verschiedenen Knoten, die Sie auf- und 
zuklappen können, sofern Kindknoten existieren. In der rechten Spalte werden die 
Inhalte der Knoten angezeigt.

Über das Kontextmenü können Sie die folgenden Aktionen ausführen:

Remove: Markierten Knoten entfernen
Add DTD Information: Strukturdefinition in Form einer DTD (Document Type 
Definition) hinzufügen
Edit Namespaces: Namensräume bearbeiten
Add Attribute: Neues Attribut hinzufügen
Add Child: Neuen Kindknoten (Element, Processing Instruction usw.) hinzufügen
Add Before: Neuen Knoten vor dem markierten Knoten einfügen
Add After: Neuen Knoten hinter dem markierten Knoten einfügen

Source In der Sicht Source können Sie den Quelltext von XML-Dokumenten bearbeiten.

Dabei unterstützt Sie der Editor durch folgende Funktionen:

Syntax-Highlighting: Die verschiedenen Knotentypen werden farblich 
hervorgehoben.

Wohlgeformtheit: Beim Speichern erfolgt eine Prüfung auf Wohlgeformtheit des 
XML-Dokuments.

Eingabehilfe: Der Editor macht Vorschläge, wenn Sie neue Elemente einfügen 
möchten.

Pretty-Print: Über das Menü Source > Format können Sie Ihr XML-Dokument mit 
Einrückungen und Zeilenumbrüchen lesbarer formatieren.
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2 BPMN-Prozessbausteine und ihre Verwendung
Am rechten Rand der Zeichnungsfläche befindet sich eine ausklappbare Werkzeugleiste, die Palette. 
Sie enthält Prozessbaustein-Symbole, die Sie per Drag&Drop in die Zeichnungsfläche ziehen können. 
Folgende Prozessbausteine stehen für die Modellierung von Business Processes (.bpm) zur 
Verfügung:

2.1 Events
Beim Anlegen eines neuen Business Process werden standardmäßig bereits ein Start- und ein End-
Event in das Prozess-Diagramm eingefügt. Darüber hinaus lassen sich weitere Event-Bausteine aus 
der Palette in das Prozess-Diagramm ziehen und bei der Prozess-Modellierung verwenden. Die 
verfügbaren Bausteine werden im Folgenden näher erläutert.

2.1.1 Start

 Start: Definiert gemäß BPMN 2.0 das Start-Ereignis des Business Processes und ermöglicht 
die Unterscheidung hinsichtlich verschiedener Ereignistypen.

Eigenschaften

Case Management
Case State Vorgangs-Status, der mit diesem Element gesetzt werden soll

Mögliche Werte: Bereits definierte Vorgangs-Statuswerte; Sie können die 
verfügbaren Vorgangs-Statuswerte mit Klick auf , siehe 
Vorgangs-Statuswerte verwalten.

Technical
Label Beschriftung des Symbols im Prozess-Diagramm

 verwalten
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Event Ereignistyp

Mögliche Werte:

None Start: Allgemeines Start-Ereignis (Standard)

Error Start: Start-Ereignis bei einem Fehler

Message Start: Nachrichtenbasiertes Start-Ereignis

Multiple Start: Mehrfaches Start-Ereignis

Conditional Start: Start-Ereignis basierend auf einer 
Geschäftsregel

Signal Start: Start-Ereignis, das einem Signal folgt

Timer Start: Zeitgesteuertes Start-Ereignis

Escalation Start: Start-Ereignis basierend auf eine Eskalation
Compensation Start: Start-Ereignis, das auf eine Kompensierung 
basiert
Parallel Multiple Start: Mehrfaches paralleles Start-Ereignis

Vorgangs-Status über das Start-Event setzen

Mit dem Start-Event können Sie den Status eines Vorgangs setzen, der zur Laufzeit des Business 
Processes bearbeitet werden soll. Hierzu stehen in Eigenschaft Case Management > Case 
State alle prozessweit definierten Vorgangs-Statuswerte zur Auswahl zur Verfügung. Dazu gehen Sie 
wie folgt vor:

Start-Baustein im Prozess auswählen.
In der Properties-Sicht in Eigenschaft Case Management > Case State einen bereits 
hinterlegten Vorgangs-Status auswählen, z. B. START.

Der Vorgangs-Status wird nun bei der Ausführung dieses Business Processes auf den neuen 
Wert gesetzt. Dies wird durch eine entsprechende Beschriftung des Events gekennzeichnet.

Falls noch kein Wert in Eigenschaft Case State zur Auswahl steht, so wurde noch kein 
Vorgangs-Status für den Business Process definiert. Die verfügbaren Vorgangs-
Statuswerte können Sie neben dem Wert von Eigenschaft Case State mit Klick auf 

 verwalten, siehe Vorgangs-Statuswerte verwalten.



Alternativ kann der Vorgangs-Status auch dynamisch über Technical Processes gesetzt 
werden. Hierzu steht der Case Management Adapter zur Verfügung.


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2.1.2 Intermediate

 Intermediate: Definiert gemäß BPMN 2.0 ein Zwischenereignis innerhalb eines Business 
Processes und ermöglicht es zudem einen Vorgangs-Statuswert über die Eigenschaft Case State zu 
setzen, siehe Vorgangs-Statuswerte verwalten.

Eigenschaften

Case Management
Case 
State

Vorgangs-Status, der mit diesem Element gesetzt werden soll

Mögliche Werte: Bereits definierte Vorgangs-Statuswerte; Sie können die verfügbaren 

Vorgangs-Statuswerte mit Klick auf , siehe Vorgangs-
Statuswerte verwalten.

Technical
Docum
ent

Pfad zum entsprechenden Prozess im X4 Repository

Label Beschriftung des Symbols im Prozess-Diagramm

 verwalten
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1.
2.

Event Ereignistyp

Mögliche Werte:

None Intermediate: Allgemeines Zwischen-Ereignis (Standard)

Message Intermediate (Catch): Eingehendes Nachrichten-Zwischen-Ereignis
Message Intermediate (Throw): Ausgehendes Nachrichten-Zwischen-Ereignis

Cancel Intermediate: Abbruch-Zwischen-Ereignis

Compensation Intermediate (Catch): Eingehendes Kompensations-Zwischen-
Ereignis

Compensation Intermediate (Throw): Ausgehendes Kompensations-Zwischen-
Ereignis

Error Intermediate: Fehler-Zwischen-Ereignis
Escalation Intermediate (Catch): Eingehendes Eskalations-Zwischen-Ereignis

Escalation Intermediate (Throw): Ausgehendes Eskalations-Zwischen-Ereignis

Multiple Intermediate (Catch): Eingehendes Mehrfach-Zwischen-Ereignis

Multiple Intermediate (Throw): Ausgehendes Mehrfach-Zwischen-Ereignis

Conditional Intermediate: Geschäftsregel-Zwischen-Ereignis

Signal Intermediate (Catch): Eingehendes Signal-Zwischen-Ereignis

Signal Intermediate (Throw): Ausgehendes Signal-Zwischen-Ereignis

Parallel Multiple Intermediate: Mehrfaches Parallel-Zwischen-Ereignis
Link Intermediate (Catch): Eingehendes Link-Zwischen-Ereignis
Link Intermediate (Throw): Ausgehendes Link-Zwischen-Ereignis

Vorgangs-Status mit Intermediate Events setzen

Mit Intermediate Events können Sie den Status eines Vorgangs setzen, der zur Laufzeit des aktuellen 
Business Processes bearbeitet werden soll. Hierzu stehen in Eigenschaft Case Management > Case 
State alle prozessweit definierten Vorgangs-Statuswerte zur Auswahl zur Verfügung. Dazu gehen Sie 
wie folgt vor:

Intermediate Event aus der Palette in den Zeichnungsbereich ziehen.
Für das markierte Event-Element in der Properties-Sicht in Eigenschaft Case Management > 
Case State einen bereits hinterlegten Vorgangs-Status auswählen, z. B. IN PROGRESS.

Falls noch kein Wert in Eigenschaft Case State zur Auswahl steht, so wurde noch kein 
Vorgangs-Status für den Business Process definiert. Die verfügbaren Vorgangs-
Statuswerte können Sie neben dem Wert von Eigenschaft Case State mit Klick auf 

 verwalten, siehe Vorgangs-Statuswerte verwalten.


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Der Vorgangs-Status wird nun bei der Ausführung diesesBusiness Processes auf den neuen 
Wert gesetzt. Dies wird durch eine entsprechende Beschriftung des Events gekennzeichnet.

2.1.3 Timer-based Intermediate

 Timer-based Intermediate : Definiert gemäß BPMN 2.0 ein zeitgesteuertes 
Zwischenereignis innerhalb eines Business Processes und ermöglicht es zudem einen Vorgangs-
Statuswert über die Eigenschaft Case State zu setzen, siehe Vorgangs-Statuswerte 
verwalten .Eigenschaften

Case Management
Case 
State

Vorgangs-Status, der mit diesem Element gesetzt werden soll

Mögliche Werte: Bereits definierte Vorgangs-Statuswerte; Sie können die verfügbaren 
Vorgangs-Statuswerte mit Klick auf , siehe Vorgangs-Statuswerte verwalten.

Technical
Durat
ion

Wartezeit bis zum Eintreten des Ereignisses

Mögliche Werte:

Beliebige Dauer mit Angabe Tagen, Stunden, Minuten, Sekunden und Millisekunden

                      9999d 23h 59m 59s 999ms
                    : Maximale Wartezeit

                      0d 0h 0m 0s 0ms
                    : Keine Wartezeit (Standard)

 Alternativ zur Angabe einer Wartezeit lässt sich über Until ein Endzeitpunkt festlegen.

Sie können die Wartezeit-Konfiguration mit Klick auf 

Label Beschriftung des Symbols im Prozessdiagramm

2.1.3.1 Zeitgesteuertes Ereignis konfigurieren

Timer-based Intermediate Event aus der Palette ins Prozessdiagramm ziehen.
Für das markierte Event-Element in der Properties-Sicht in Eigenschaft Case State einen 
bereits hinterlegten Vorgangs-Status auswählen, z. B. 

Alternativ kann der Vorgangs-Status auch dynamisch über Technical Processes gesetzt 
werden. Hierzu steht der Case Management Adapter zur Verfügung.



 verwalten

 oder per Doppelklick auf den Event im Prozessdiagramm öffnen.
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4.

5.

            IN PROGRESS
          .

Der Vorgangs-Status wird nun bei der Ausführung dieses Business Processes auf den neuen 
Wert gesetzt. Dies wird durch eine entsprechende Beschriftung des Events gekennzeichnet.

Wartezeit-Konfiguration mit Klick auf neben der Eigenschaft Duration oder per Doppelklick 
auf den Event im Prozessdiagramm öffnen.

Gewünschte Wartezeit durch Angabe von Tagen, Stunden, Minuten, Sekunden 
und Millisekunden konfigurieren.

Die Konfiguration mit OK speichern.

2.1.3.2 Zeitgesteuerte Ereignisse dynamisch konfigurieren

Zeitgesteuerte Ereignisse lassen sich auch dynamisch über Technical Processes und einem 
entsprechenden Mapping konfigurieren. Der entsprechende Technical Process wird über das Timer-

Falls noch kein Wert in Eigenschaft Case State zur Auswahl steht, so wurde noch kein 
Vorgangs-Status für den Business Process definiert. Die verfügbaren Vorgangs-
Statuswerte können Sie neben dem Wert von Eigenschaft Case State mit Klick auf 

 verwalten, siehe Vorgangs-Statuswerte verwalten.



Alternativ kann der Vorgangs-Status auch dynamisch über Technical Processes 
gesetzt werden. Hierzu steht der Case Management Adapter zur Verfügung.



Alternativ zur Angabe einer Wartezeit lässt sich über Until ein Endzeitpunkt festlegen.
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based Intermediate Event angelegt und verwaltet. Er wird direkt unter dem entsprechenden Business 
Process angelegt und kann auch nicht verschoben werden.  

Wartezeit-Konfiguration mit Klick auf  neben der Eigenschaft Duration oder per Doppelklick 
auf den Event im Prozessdiagramm öffnen.

Unter Dynamic Configuration auf Create klicken. 

Prozessnamen eingeben und mit OK bestätigen.
Der Technical Process wird nun unterhalb des Business Process angelegt und kann hier weiter 
bearbeitet werden.

Der Technical Process muss dabei folgende Zielstruktur liefern:

Beispielstruktur: Dauer

<timerBasedConfiguration>
    <durationDay>0</durationDay>
    <durationHour>0</durationHour>
    <durationMinute>0</durationMinute>
    <durationSecond>10</durationSecond>
    <durationMillis>0</durationMillis>
</timerBasedConfiguration> 



X4 BPM

© SoftProject GmbH 44

Beispielstruktur: Zeitpunkt

<?xml version="1.0" encoding="UTF-8" standalone="yes"?>
<timerBasedConfiguration>
    <untilTimestamp>2020-03-17T17:00:00</untilTimestamp>
</timerBasedConfiguration>

2.1.4 Non-Interrupting Intermediate Event

 Non-interrupting intermediate events: Definiert gemäß BPMN 2.0 ein beliebiges nicht-
unterbrechendes Zwischen-Ereignis (Non-interrupting Intermediate Event) innerhalb eines Business 
Processes und ermöglicht die Unterscheidung hinsichtlich verschiedener Ereignistypen. Im 
Unterschied zu Intermediate Events wird bei einem Non-Interrupting Intermediate Event die 
Bearbeitung der Aktivität nicht unterbrochen, der durch das Ereignis eingeleitete Pfad wird parallel 
aktiviert und durchlaufen.

Eigenschaften

Docu
ment

Pfad zum entsprechenden Prozess im X4 Repository

Labe
l

Beschriftung des Symbols im Prozessdiagramm

Non-Interrupting Intermediate Events stehen lediglich im so genannten Free-flow mode des 
BPMN Editors zur Verfügung. Der Free-flow mode lässt sich beim Anlegen von BPM-
Prozessen aktivieren und bietet eine erweiterte Zeichen-Palette. Im Vergleich zum Standard-
Modus ist im Free-flow mode die Run/Debug-Funktion deaktiviert. Zudem lässt sich der 
Modus nachträglich nicht mehr verändern.


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Ereignistyp

Mögliche Werte:

Non-Interrupting Message Intermediate (Catch): Eingehendes nicht-
unterbrechendes Nachrichten-Zwischen-Ereignis

Non-Interrupting Message Intermediate (Throw): Ausgehendes nicht-
unterbrechendes Nachrichten-Zwischen-Ereignis

Non-Interrupting Escalation Intermediate (Catch): Eingehendes nicht-
unterbrechendes Eskalations-Zwischen-Ereignis

Non-Interrupting Escalation Intermediate (Throw): Ausgehendes nicht-
unterbrechendes Eskalations-Zwischen-Ereignis

Non-Interrupting Multiple Intermediate (Catch): Eingehendes nicht-
unterbrechendes Mehrfach-Zwischen-Ereignis

Non-Interrupting Multiple Intermediate (Throw): Ausgehendes nicht-
unterbrechendes Mehrfach-Zwischen-Ereignis

Non-Interrupting Conditional Intermediate: Nicht-unterbrechendes 
Geschäftsregel-Zwischen-Ereignis
Non-Interrupting Signal Intermediate (Catch): Eingehendes nicht-
unterbrechendes Signal-Zwischen-Ereignis

Non-Interrupting Signal Intermediate (Throw): Ausgehendes nicht-
unterbrechendes Signal-Zwischen-Ereignis

Non-Interrupting Timer Intermediate: Zeitgesteuertes nicht-unterbrechendes
Zwischen-Ereignis

Non-Interrupting Parallel Multiple Intermediate: Mehrfaches nicht-
unterbrechendes Parallel-Zwischen-Ereignis

2.1.5 End

 End: Definiert gemäß BPMN 2.0 ein End-Ereignis des Business Processes.

Eigenschaften

Case Management
Case 
State

Vorgangs-Status, der mit diesem Element gesetzt werden soll

Mögliche Werte: Bereits definierte Vorgangs-Statuswerte; Sie können die verfügbaren 
Vorgangs-Statuswerte mit Klick auf , siehe Vorgangs-Statuswerte 
verwalten.

Technical
Label Beschriftung des Symbols im Prozess-Diagramm

 verwalten
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1.
2.

Event Ereignistyp

Mögliche Werte:

None End: Allgemeines End-Ereignis (Standard)

Terminate End: Abbrechendes End-Ereignis (für alle Prozess-Instanzen)

Message End: Nachrichtenorientiertes End-Ereignis

Cancel End: Abbrechendes End-Ereignis (der laufenden Prozess-Instanz)
Compensation End: Kompensierendes End-Ereignis

Error End: End-Ereignis bei einem Fehler

Escalation End: Eskalierendes End-Ereignis

Multiple End: Mehrfaches End-Ereignis

Signal End: End-Ereignis, das einem Signal folgt

Vorgangs-Status über das End-Event setzen

Mit dem End-Event können Sie den Status eines Vorgangs setzen, der zur Laufzeit des Business 
Processes bearbeitet werden soll. Hierzu stehen in Eigenschaft Case Management > Case 
State alle prozessweit definierten Vorgangs-Statuswerte zur Auswahl zur Verfügung. Dazu gehen Sie 
wie folgt vor:

End-Baustein im Prozess auswählen.
In der Properties-Sicht in Eigenschaft Case Management > Case State einen bereits 
hinterlegten Vorgangs-Status auswählen, z. B. START.

Der Vorgangs-Status wird nun bei der Ausführung dieses Business Processes auf den neuen 
Wert gesetzt. Dies wird durch eine entsprechende Beschriftung des Events gekennzeichnet.

Falls noch kein Wert in Eigenschaft Case State zur Auswahl steht, so wurde noch kein 
Vorgangs-Status für den Business Process definiert. Die verfügbaren Vorgangs-
Statuswerte können Sie neben dem Wert von Eigenschaft Case State mit Klick auf 

 verwalten, siehe Vorgangs-Statuswerte verwalten.



Alternativ kann der Vorgangs-Status auch dynamisch über Technical Processes gesetzt 
werden. Hierzu steht der Case Management Adapter zur Verfügung.


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2.2 Activities

2.2.1 Activity

 Activity: Definiert gemäß BPMN 2.0 eine Aktivität innerhalb eines Business Processes. Der 
Aktivitätstyp sowie dessen Ausführungsverhalten wird durch entsprechende Eigenschaften 
festgelegt bzw. durch Marker gekennzeichnet. Mit einem Aktivitäts-Baustein lassen sich je nach 
Anwendungsfall Technical Processes oder weitere Business Processes als Subprozesse verknüpfen. 

Eigenschaften

Business
Ad hoc Markierung als Ad-hoc-Aktivität durch das Symbol 
Compensation Markierung als kompensierende Aktivität durch das Symbol 
Activity 
type

Kennzeichnung des Aktivitätstyps

Verfügbare Aktivitätstypen:

None: Allgemeine Aktivität, ohne zusätzliche Markierung (Standard)
 Send: Senden
 Receive: Empfangen
 Manual: Manuelle Aktivität
 Service: Dienst(prozess)
 Script: Skript

Execution 
type

Kennzeichnung des Ausführungsverhaltens

Verfügbare Ausführverhaltens-Marker:

Single: Einfache Ausführung (Standard)
 Loop: Schleife
 Parallel Multi-Instance: Parallele Mehrfachausführung
 Sequential Multi-Instance: Sequenzielle Mehrfachausführung

Technical
Document Pfad zum verknüpften Prozess im X4 Repository (vom X4 Designer gesetzt). Wird ein 

Baustein-Symbol aus der Palette per Drag&Drop auf der Zeichnungsfläche 
eingefügt, so handelt es sich lediglich um einen leeren Prozessbaustein ohne Bezug 
zu einer Datei im Repository.

Label Beschriftung des Symbols im Prozessdiagramm

Die Markierung  (Teilprozess) wird automatisch gesetzt, sobald ein Business Process 
(*.bpm) verknüpft ist.


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2.2.2 Human Task

 Human Task: Mit Human Tasks lassen sich menschliche Aktivität abbilden. Bei der 
Automatisierung des Business Processes werden diese Human Tasks mit ausführbaren .humantask-
Dateien verknüpft.

Ein Human Task (.humantask) ermöglicht die Konfiguration der Task Management Web App und 
damit die Interaktion mit von Menschen ausgeführten Aufgaben, die im Case Management als 
Vorgang modelliert werden, siehe Case Management – Vorgänge und Workflows 
realisieren. Eigenschaften

Label Beschriftung des Symbols im Prozess-Diagramm

2.2.2.1 Human Tasks anlegen und verwenden

Um menschliche Interaktionen in Business Processes besser abzubilden, können bei der Modellierung 
vonBusiness Processes Human Tasks verwendet werden. Diese lassen sich anschließend mit einer 
Human-Task-Datei (.humantask) verknüpfen in der die Konfiguration des Task vorgenommen wird.

Human Tasks (.humantask) werden unterhalb des Business Processes über das Kontextmenü New > 

Human task oder über die Symbolleiste   > Add Human task angelegt. Nach dem Anlegen wird der 
Human Task im X4 Designer geöffnet und kann wie folgt parametriert werden:

Title: Titel der Aufgabe in der Task Management Web App

Description: Optionale Beschreibung der Aufgabe
Registerkarte General: Besitzer, zugewiesenen Benutzer oder Gruppe und Frist für die 
Abarbeitung definieren
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Owner: Besitzer der Aufgabe
Assigned User/Group: Zugewiesener Benutzer 
oder Gruppe für die Aufgabe

Deadline: Frist für die Abarbeitung der Aufgabe mit 
folgenden Optionen:

No deadline: Keine Frist
Duration: Dauer der Frist in Tagen, Stunden 
und Minuten
Until: Datum und Uhrzeit zu dem die 
Aufgabe abgearbeitet werden muss
Case State: Case State der automatisch 
ausgeführt wird, wenn die Frist des Human 
Tasks erreicht wurde

Registerkarte Business Data: Anzuzeigende Informationen für die Task Management Web App 
definieren

Die beteiligten Benutzer und Gruppen 
werden im Keycloak angelegt und verwaltet.



Wird ein Human Task mit einer 
festgelegten Frist ausgeführt, wird 
der Prozess automatisch mit dem 
konfigurierten Case State
fortgesetzt, nachdem die Frist 
erreicht wurde. Der Human Task wird 
in diesem Fall automatisch 
geschlossen und innerhalb der Task 
Management Web App im Navigator-
Ordner Verfallen angezeigt. Hier 
werden alle Human Tasks angezeigt, 
die die Frist überschritten haben und 
automatisch geschlossen worden 
sind.

Ist hingegen kein Case State gesetzt, 
wird der Prozess auch nicht 
automatisch fortgesetzt. 


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Key Identifier: Case-Feature als 
Schlüsselkennzeichnung in der Task 
Management Web App
Kategorien, Feature-Gruppen und Features 
werden in einer baumartigen Struktur angezeigt 
und können ausgewählt werden für die 
Sichtbarkeit in der Task Management Web App

 Kategorien werden als Tabs in der Task 
Management Web App angezeigt.
Display Name: Anzeigename der ausgewählten 
Kategorie, der Feature-Gruppe oder des 
Features
read only: Ausgewählte Kategorie, Feature-
Gruppe und Feature als schreibgeschützt 
kennzeichnen

Registerkarte Actions: Auszuführende Aktionen für die Task Management Web App definieren
Unter Actions können die Statuswerte 
angegeben werden, die vom Benutzer in der 
Task Management Web App für einen Vorgang 
gesetzt werden können
Display Name: Anzeigename des ausgewählten 
Case States in der Task Management Web App

Registerkarte Settings: Erweiterte Einstellungen für die Ver- und Bearbeitung von Vorgängen
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Im Bereich Advanced das Ablehnen und Weiterleiten von 
Tasks erlauben sowie den Zugriff auf Human Tasks über eine 
Schnittstelle erlauben, siehe Über ReST-Schnittstelle auf 
Human Tasks zugreifen.

Task can be declined: Tasks können 
abgelehnt werden
Task can be forwarded: Tasks können 
weitergeleitet werden
Task can be resubmitted: Tasks können auf 
Wiedervorlage gesetzt werden
Enable access via API: Den Zugriff auf des 
Task über eine Schnittstelle erlauben

Im Bereich Documents das Hinzufügen, Bearbeiten und 
Löschen von Dokumenten zu einem Vorgang erlauben. 

Enable Documents: Die Verarbeitung von 
Dokumenten erlauben 
Documents can be added/edited: 
Das Hinzufügen und Bearbeiten von 
Dokumenten erlauben
Documents can be deleted: Das Löschen von 
Dokumenten erlauben

2.2.2.2 Human Task über einen Technical Process dynamisch parametrieren

Human Tasks lassen sich nicht nur über Human-Task-Dateien konfigurieren, sondern auch dynamisch 
über Technical Processes.

Folgende Einstellungen des Human Tasks lassen sich im Technical Process übersteuern: 

Owner
Assignee
Deadline

Der Technical Process zur Parametrierung des Human Tasks wird direkt unter dem Human Task über 
das Kontextmenü New > Process angelegt und kann auch nicht verschoben werden.  

Über den Task Management Adapter lassen sich 
zusätzliche Aktionen für einen Human Task 
definieren.



Ausführung auf dem X4 Server
Läuft ein Business Process während der Ausführung auf einen Human Task, wird die 
Ausführung des Prozesses angehalten und die menschlichen Aufgabe generiert. Der Prozess 
wartet auf die notwendige menschliche Interaktion innerhalb der Task Management Web App 
und setzt die Ausführung fort, sobald die menschliche Aufgabe zu dem Prozess 
abgeschlossen ist. 


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1.
2.
3.

Das Input- und Output-Dokument für den Technical Process sieht wie folgt aus:

Struktur des Input- und Output-Dokuments

<?xml version="1.0" encoding="UTF-8" standalone="yes"?>
<HumanTask>
    <Owner>OwnerName</Owner>
    <Assignee>
        <name>AsigneeName</name>
        <type>user|group</type>
    </Assignee>
     
    <!-- Deadline types (NoDeadline, DurationDeadline, UntilDeadline)-->
    <NoDeadline />
 
    <DurationDeadline>
        <Days>7</Days>
        <Hours>4</Hours>
        <Minutes>45</Minutes>
    </DurationDeadline>
 
    <UntilDeadline>2019-04-18T14:30:49+02:00</UntilDeadline>
</HumanTask>

2.2.2.3 Über ReST-Schnittstelle auf Human Tasks zugreifen

Anstelle der Task Management Web App können auch andere Anwendungen für die Anzeige und 
Bearbeitung von Human Tasks verwendet werden. Die Anbindung findet über eine Webservice-
basierte Schnittstelle statt, die alle Funktionalitäten bietet, die auch in der Task Management Web 
App verfügbar sind.

Um die Anbindung über die ReST-Schnittstelle zu ermöglichen, müssen folgende Einstellungen im 
Human Task vorgenommen werden:

Human Task öffnen.
Die Registerkarte Settings öffnen.
Im Bereich Advanced die Option Enable access via API wählen.
Der Zugriff ist nun ausschließlich über die Schnittstelle möglich.

Der Zugriff auf den Human Task über die ReST-Schnittstelle kann pro .humantask-Datei 
ermöglicht werden.



Die Dokumentation der ReST-Schnittstelle finden Sie unter http://localhost:8080/X4/X4Api/.

http://localhost:8080/X4/X4Api/
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2.2.2.4 Über ReST-Schnittstelle authentifizieren

Um sich über die ReST-Schnittstelle zu authentifizieren, verwenden Sie das "Basic" HTTP 
Authentifikationsschema oder einen X4-Token.

Je nach verwendetem Authentifikationsschema muss der HTTP Request Header wie folgt aussehen:

2.2.2.4.1 "Basic" HTTP Authentifikationsschema

Parameter Wert
ReST Request Method GET

Host X4-Server:Port

Path /X4/services/rest/tasks/login

ReST Request 
Header

Header name Authorization

Header value Basic <Benutzername:Passwort>

Sie erhalten einen X4-Token (JSON Web Token), den Sie für weitere ReST-Request verwenden 
können.

Beispiel Header

authorization: Basic YWRtaW46ZGVtbw==

Benutzername:Passwort wird als Base64-kodierter 
String angegeben.


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2.2.2.4.2 X4-Token

Für weitere ReST-Requests muss der ReST Request Header wie folgt aussehen:

Parameter Wert
ReST Request 
Header

Header name Authorization

Header value X4Token <X4-Token>

Beispiel Header

authorization: X4Token J0eXAiOiJKV1QiLCJhbGciOiJIUzI1NiJ9...
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2.2.3 Rule

 Rule: Mit dem Rule-Baustein lassen sich Regeln für Entscheidungen innerhalb eines 
Business Processes abbilden. Die anzuwendenden Regeln werden dabei innerhalb von 
Entscheidungstabellen (.rule) nach DMN 1.1 definiert. Die Regeln können automatisiert geprüft und 
die Ergebnisse für die Weiterverarbeitung an den Business Process zurückzugeben werden.

Eigenschaften

Label Beschriftung des Symbols im Prozessdiagramm

2.2.3.1 Rules anlegen und definieren

DMN ist ein Standard zur Modellierung von Entscheidungen in Business Processes. Im 
Standard DMN ist auch die Simple Expression Language (S-FEEL) definiert, eine formale 
Ausdruckssprache zur Definition einer Entscheidungslogik.
DMN 1.1 mit S-FEEL ist online verfügbar unter https://www.omg.org/spec/DMN/1.1/.



•
•

Defaultwerte des Typs Integer und Decimal können nicht leer sein.
Bei den Typen Integer und Decimal kann nicht geprüft werden, ob der Wert leer ist.



https://www.omg.org/spec/DMN/1.1/
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Um Regeln für Entscheidungen in Business Processes besser abzubilden, können bei der 
Modellierung von Business Processes Rule-Bausteine verwendet werden. Diese lassen sich 
anschließend mit einer Entscheidungtabelle (.rule) verknüpfen, in der die Definition der Regeln 
vorgenommen wird.

Entscheidunstabellen (.rule) werden unterhalb des Business Processes über das Kontextmenü New 

> Rules oder über die Symbolleiste   > Add Rules angelegt. Nach dem Anlegen wird die 
Entscheidungstabelle im X4 Designer geöffnet.

Nr. Element Beschreibung
1 Werkzeugleiste Funktionen zum Bearbeiten von Entscheidungstabellen, abhängig von 

Kontext und Auswahl

Verkettung von Entscheidungstabellen
Es können beliebig viele Entscheidungstabellen in einem Business Process verkettet 
werden. Ausgangswerte der einen Tabelle werden somit zu Eingangswerten der 
nachfolgenden. Dadurch lassen sich komplexe Entscheidungsbäume mit entsprechenden 
Verzweigungen modellieren.


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1.
2.

•

•

•

•
•

3.
4.

Nr. Element Beschreibung
2 Kopfbereich Einstellungen zur Definition von Input und Output, wobei mehrere Inputs 

und Outputs möglich sind.

Folgende Zellen sind zur Definition des Inputs und Outputs verfügbar:

Freitextfeld für den Spalten-Namen
Input- bzw. Output-Quelle 

Input bzw. Output: Input aus dem BPMN-Prozess 
bzw. Output an den BPMN-Prozess
Placeholder: Auswahl eines Platzhalters (nur für Input 
verfügbar)
Variable: in einer Variable hinterlegter Wert (ohne 
Leerzeichen, z. B. FreigabeDurch)
Case State: Auswahl eines Status
Case Feature: Auswahl von Fachdaten

Datentyp des Inputs bzw. Outputs (string, number, boolean)
Input-Pfad als Freitextfeld oder Auswahl (je nach Input-Quelle) 
bzw. Name des Outputs oder der Variablen als Freitextfeld oder 
Auswahl (je nach Output-Ziel)

3 Annotation Freie Anmerkung, die nicht im Output ausgegeben wird
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Nr. Element Beschreibung
4 Regeln Regeln für die Transformation von Inputs zu Outputs.

Regeln werden pro Zeile definiert, wobei die Reihenfolge der Zeilen die 
Überprüfungsreihenfolge vorgibt. Eine Regel hat mindestens eine Spalte 
zur Verarbeitung der Eingangswerte (Input) und mindestens ein 
Entscheidungs-Ergebnis (Output).

Die Regeln in der Entscheidungstabelle werden in der S-FEEL-Notation 
angegeben. Damit lässt sich die Entscheidungslogik in natürlicher Sprache 
"business-friendly" beschreiben. Gleichzeitig erlaubt sie als formale 
Auszeichnungssprache mit festgelegter Semantik, Grammatik und 
definierten Regeln die Interpretation und das Ausführen von Werten. S-
FEEL kann Zeichenketten, Zahlen, einfache arithmetische Operationen 
und simple Vergleichsprüfungen interpretieren.

•

•

•

•

Beachten Sie:

Zeichenketten in Anführungszeichen setzen, z. B. 
"Abteilungsleiter"
Für Dezimalzahlen einen Punkt als Trennzeichen verwenden, 
z. B. 5.1
Ist der Wert einer Zelle der Input-Spalte nicht für eine Regel 
relevant, entsprechend S-FEEL ein - (Minuszeichen) in die Zelle 
eingeben
Eine Entscheidungstabelle kann eine Fallback-Regel enthalten, 
die immer zutreffen soll. Hierzu enthalten alle Zellen der Input-
Spalten einer Fallback-Regel ein - (Minuszeichen).
Ob eine Fallback-Regel sinnvoll ist und an welcher Stelle der 
Überprüfungsreihenfolge sie stehen sollte, hängt von der Hit 
Policy und dem Anwendungsfall ab.


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•
•

•
•

Nr. Element Beschreibung
5 Hit Policy Einstellung zur Auswahl der Ergebnisse. Sie legt fest, wie viele Regeln 

einer Entscheidungstabelle zutreffen können und wie die Ergebnisse 
ausgegeben werden.

Bedeutung Möglicher Verstoß gegen die Hit 
Policy

U (Unique): Nur eine Regel kann 
zutreffen und es wird genau ein 
Ergebnis ausgegeben.

Keine zutreffende Regel
Mehrere zutreffende 
Regeln

F (First): Eine oder mehrere Regeln 
können zutreffen, es wird aber nur das 
erste Ergebnis ausgegeben.

 Überprüfungsreihenfolge beachten!

Keine zutreffende Regel

A (Any): Eine oder mehrere Regeln mit 
demselben Ergebnis können zutreffen, 
es wird jedoch nur ein Ergebnis 
ausgegeben.

Keine zutreffende Regel
Mehrere zutreffende 
Regeln mit 
unterschiedlichen 
Ergebnissen

C (Collect): Alle zutreffenden 
Ergebnisse werden ohne feste 
Ausgabereihenfolge ausgegeben.

Keine zutreffende Regel

Regeln können so definiert werden, dass die Anzahl und Auswahl 
der Ergebnisse gegen die Hit Policy verstößt. In diesem Fall 
müssen je nach Anwendungsfall die Regeln oder die Hit Policy 
korrigiert werden.



•
•
•

Der fertige BPMN-Prozess mit der Entscheidungstabelle kann im X4 Designer validiert, auf 
Fehler überprüft und auf dem X4 Server ausgeführt werden.
Entscheidungstabellen können zu drei Ergebnissen führen:
Icon Beschreibung

Der Rule-Baustein liefert ein oder mehrere Ergebnisse. Das Zwischenergebnis ist 
aufrufbar.

Der Rule-Baustein liefert keine Ergebnisse. Mögliche Ursachen:

Für den Input gilt keine der definierten Regeln
Regeln fehlerhaft, z. B. Schreibfehler
Hit Policy nicht geeignet

Der Rule-Baustein liefert einen Fehler, da die Entscheidungstabelle nicht konform 
zu S-FEEL ist. Ein Bericht mit einer Erklärung des Fehlers ist aufrufbar.


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•
•
•

•

2.2.3.2 S-FEEL-Ausdrücke zur Definition von Regeln

Operator / Ausdruck Beschreibung
Vergleic
h

10 Prüft, ob der Eingabewert gleich dem angegebenen Wert 
ist, z. B. 10

v:[Variablenname]
f:[Featurename]
p:
[Platzhaltername]
c:[CaseState]

Führt eine Prüfung auf Basis einer Variablen, eines 
Features, eines benutzerdefinierten Platzhalters oder eines 
Vorgangs-Statuswertes (Case State) durch

< Prüft, ob der Eingabewert kleiner als der angegebene Wert 
ist, z. B. < 10

<= Prüft, ob der Eingabewert kleiner oder gleich dem 
angegebenen Wert ist, z. B. <= 10

> Prüft, ob der Eingabewert größer dem angegebenen Wert 
ist, z. B. > 10

>= Prüft, ob der Eingabewert größer oder gleich dem 
angegebenen Wert ist, z. B. >= 10

not() Prüft, ob der Eingabewert nicht kleiner oder gleich dem 
angegebenen Wert ist, z. B. not(<=10)

Intervall [1..10] Prüft, ob der Eingabewert größer oder gleich dem Startwert 
und kleiner oder gleich dem Endwert ist

(1..10] Prüft, ob der Eingabewert größer als der Startwert und 
kleiner oder gleich dem Endwert ist

[1..10) Prüft, ob der Eingabewert größer oder gleich dem Startwert 
und kleiner als der Endwert ist

(1..10) Prüft, ob der Eingabewert größer als der Startwert und 
kleiner als der Endwert ist

Disjunkti
on

3,5,7 Prüft, ob der Eingabewert 3,5 oder 7 ist

<2,>10 Prüft, ob der Eingabewert weniger als 2 oder mehr als 10 ist
10,[20..30] Prüft, ob der Eingabewert entweder 10 oder zwischen 20 

und 30 ist
"Meier", "Müller, "Weber" Prüft, ob der Eingabewert entweder Meier, Müller oder 

Weber ist

Mit Strg + Leertaste lassen sich alle aktuell 
verfügbaren Variablen, Features, 
Benutzerdefinierten Platzhalter und Vorgangs-
Statuswerte in einer Auswahlliste aufrufen.



Eine umfangreiche Referenz zur Syntax der S-FEEL Notation finden Sie in der aktuelle 
Spezifikation zu DMN 1.1 (Kapitel 9) der Object Management Group. https://www.omg.org/
spec/DMN/1.1 



https://www.omg.org/spec/DMN/1.1
https://www.omg.org/spec/DMN/1.1
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•

•

•

•

2.3 Sequence Flow

 Sequence Flow: Verbindet in einem Business Process die einzelnen Events, Gateways und 
Activities und definiert die Reihenfolge der Prozess-Schritte durch seine Pfeilrichtung.

Eigenschaften

Label Freitextfeld zur Beschriftung der Sequenzfluss-Linie (zur übersichtlicheren Gestaltung 
bzw. Dokumentation)

Log4J Log Logging über Log4j an dieser Stelle des Prozesses mit den aktuellen Input-Daten 
aktivieren; Um das Logging über Log4j zu aktivieren, die Eigenschaft markieren und 
auf  klicken.

Mögliche Werte:

Disabled: Keine Log4j-Aktion wurde festgelegt (Standard)

Enabled: Eine Log4j-Aktion wurde festgelegt

BAM Log Logging über X4 BAM an dieser Stelle des Prozesses mit den aktuellen Input-Daten 
aktivieren; Um BAM-Logging zu aktivieren, die Eigenschaft markieren und auf 
klicken.

Mögliche Werte:

Disabled: Keine BAM-Logging-Aktion wurde festgelegt (Standard)

Enabled: Eine BAM-Logging-Aktion wurde festgelegt

Sobald Sie mit der Maus über Events, Gateways oder Activities fahren, wird ein Pfeil am 
rechten unteren Rand des Elements angezeigt. Klicken und ziehen Sie den Pfeil, um eine 
Sequenzfluss-Linie zu erstellen.


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•

•

•

•

•

•

Save Point Save Point an dieser Stelle des Prozesses setzen, um den kompletten Zustand der 
Prozess-Engine mit den verarbeiteten Daten und Statusinformationen bei der 
Ausführung einer Prozess-Instanz im Dateisystem zu persistieren. Die Prozess-Instanz 
kann vom letzen gespeicherten Save Point über X4 BAM wiederaufgesetzt werden.

Mögliche Werte:

No Savepoint: Kein Save Point wurde festgelegt (Standard)

Save and Continue: Save Point erstellen und die Prozess-Ausführung direkt 
fortsetzen

Save and Stop: Save Point erstellen und die Ausführung der Prozess-Instanz 
anhalten

Delete: aktuellen Save Point löschen

Priority Bei Gabelungen (Parallel Gateways (Forking)) und Verzweigungen (Exclusive 
Gateways (Forking)): Position in der Ausführreihenfolge (Priorität)

Mögliche Werte:

Beliebige positive ganze Zahl

1: Höchste Priorität (Standard)

Condition Bei Bedingungs-Bausteinen: vom Condition Manager hinterlegte Ausführ-Bedingung

2.4 Gateways
Innerhalb von fachlichen Prozessen (Prozessdiagramme mit der Dateiendung .bpm) können Sie 
folgende Gateways gemäß BPMN 2.0 verwenden:

2.4.1 Parallel Gateways
Parallel Gateway 
(Forking)

Definiert gemäß BPMN 2.0 ein paralleles Gateway für logische 
UND-Verzweigungen

Parallel Gateway 
(Synchronizing)

Definiert gemäß BPMN 2.0 ein synchronisierendes Gateway für die 
Zusammenführung von parallelen Sequenzflüssen

Eigenschaften

Labe
l

Freitextfeld zur Beschriftung der Verzweigung bzw. der Zusammenführung (zur 
übersichtlicheren Gestaltung bzw. Dokumentation)

Wenn Sequenzflüsse mit Parallel Gateways "parallel" modelliert wurden, bedeutet dies keine 
gleichzeitige, sondern vielmehr eine gleichberechtigte Ausführung. Die tatsächliche 
Ausführreihenfolge der parallel geführten Sequenzflüsse können Sie über deren Priorität (in 
Eigenschaft Priority) festlegen, siehe Sequence Flow.


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1.

2.

3.

4.

5.

Parallel Gateways verwenden

Parallel Gateway (Forking)-Element aus der Palette per Drag&Drop ins Prozessdiagramm 
ziehen.
Für jeden Ausführungszweig eine Sequence Flow-Linie ausgehend vom Parallel Gateway 
(Forking)-Element erstellen.
Alle Ausführungszweige werden nun unabhängig voneinander ausgeführt und besitzen 
denselben Input.
Falls gewünscht, über die Eigenschaft Priority der markierten Sequence Flow-Linie die 
Ausführreihenfolge der einzelnen Ausführungszweige verändern.

Parallel Gateway (Synchronizing)-Element aus der Palette per Drag&Drop in ein 
Prozessdiagramm ziehen.
Sequence Flow-Linien der Ausführungszweige mit dem Parallel Gateway 
(Synchronizing)-Element verbinden.
In ausführbaren Prozessen wird das Ausgabe-Dokumente des letzten ausgeführten Elements 
innerhalb der Gabelung an den nächsten Prozess-Schritt weitergegeben.

Beispiel: Parallel Gateway (Forking) mit 3 parallelen, priorisierten Verzweigungen und Parallel Gateway 
(Join):

2.4.2 Inclusive Gateways
Inclusive 
Gateway 
(Forking)

Definiert gemäß BPMN 2.0 ein datenbasiertes inklusives Gateway für logische 
ODER-Verzweigungen

Inclusive 
Gateway 
(Synchronizing
)

Definiert gemäß BPMN 2.0 ein synchronisierendes Gateway für die 
Zusammenführung von inklusiven datenbasierten Sequenzflüssen

In ausführbaren Prozessen werden die Ausführungszweige mit der niedrigsten Wert in P
riority zuerst ausgeführt.


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Eigenschaften

Labe
l

Freitextfeld zur Beschriftung der Verzweigung bzw. der Zusammenführung (zur 
übersichtlicheren Gestaltung bzw. Dokumentation)

Cond
itio
n

Ausführ-Bedingung (wird vom Condition Editor automatisch gesetzt) für die Verzweigung 
(Forking).

Auf die Übergangslinie doppelklicken, um Bedingungen zu hinterlegen oder auf   klicken, 
um den Condition Editor zu öffnen.

Beispiel: Inclusive Gateway (Forking) mit 3 inklusiven Verzweigungen und synchronisierendem 
Inclusive Gateway (Synchronizing)

2.4.3 Exclusive Gateways
Exclusive Gateway 
(Forking)

Definiert gemäß BPMN 2.0 ein Gateway für exklusive Verzweigungen

Exclusive Gateway 
(Synchronizing)

Definiert gemäß BPMN 2.0 ein synchronisierendes Gateway für die 
Zusammenführung von exklusiven datenbasierten Sequenzflüssen

Eigenschaften

Label Freitextfeld zur Beschriftung des exklusiven Verzweigung bzw. 
Zusammenführung (zur übersichtlicheren Gestaltung bzw. 
Dokumentation)

Condition Ausführ-Bedingung der Verzweigung (wird vom Condition Editor
automatisch gesetzt); auf die Übergangslinie doppelklicken, um 
Bedingungen zu hinterlegen oder auf  klicken, um den Condition 
Editor zu öffnen.

Exklusive Gateways verwenden

Inclusive Gateways führen in der Praxis schnell zu wenig sinnvollen Konstrukten. Daher 
empfehlen BPM-Experten wie Jakob Freund, Bernd Rücker und Thomas Henninger im 
Praxishandbuch BPMN (ISBN: 978-3-446-41768-7), diese Elemente sparsam zu verwenden 
und stattdessen Exclusive- und Parallel Gateways zu kombinieren.


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1.

2.

3.

4.

5.

6.

Exclusive Gateway (Forking)-Element aus der Palette per Drag&Drop ins Prozessdiagramm 
ziehen.
Für jeden Ausführungszweig eine Sequence Flow-Linie ausgehend vom Exclusive Gateway 
(Forking)-Element erstellen.
Alle Ausführungszweige besitzen denselben Input.
Exclusive Gateway (Forking)-Element doppelklicken, um die Bedingungen für die einzelnen 
Ausführungszweige festzulegen.
Der Condition Editor wird geöffnet. In diesem Editor können Sie für jede 
ausgewählte Sequence Flow-Linie eine Bedingung definieren, siehe Bedingungen erstellen und 
verwenden.
Falls gewünscht, über die Eigenschaft Priority der markierten Sequence Flow-Linie die 
Ausführreihenfolge der einzelnen Ausführungszweige verändern.

Exclusive Gateway (Synchronizing)-Element aus der Palette per Drag&Drop ins 
Prozessdiagramm ziehen.
Sequence Flow-Linien der Ausführungszweige mit dem Exclusive Gateway 
(Synchronizing)-Element verbinden.
In ausführbaren Prozessen wird das Ausgabe-Dokument des letzten ausgeführten Elements 
innerhalb der Gabelung an den nächsten Prozess-Schritt wie in technischen Prozessen 
weitergegeben.

Beispiel: Exclusive Gateway (Forking) mit 3 exklusiven Verzweigungen und synchronisierendem 
Exclusive Gateway (Synchronizing):

In ausführbaren Prozessen werden die Ausführungszweige mit der niedrigsten Wert in P
riority zuerst ausgeführt.



Da Business Processes im BPMN-Standard keine Variable-Bausteine enthalten, können 
Kontextvariablen mit Exclusive Gateways nur ausgewertet werden, wenn die 
Kontextvariablen innerhalb von technischen Prozessen definiert wurden und diese 
technischen Prozesse als Aktivität im Business Process verknüpft wurden. Hierzu stehen 
im Business Process Kontextvariablen zur Verfügung, die in verknüpften Technical 
Processes, nicht aber etwaigen Subprozessen dieser Technical Processes, initialisiert 
wurden.


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•

•

•

•

2.5 Artefakte
Innerhalb eines Business Process (Prozessdiagramme mit der Dateiendung .bpm) können Sie 
folgende Artefakte gemäß BPMN 2.0 verwenden:

2.5.1 Message Flow
 Message Flow: Werden mehrere Pools verwendet, um eine Zusammenarbeit zwischen 

verschiedenen Partnern zu modellieren, wird der Informationsaustausch zwischen diesen Pools mit 
Nachrichtenflüssen gekennzeichnet.

Eigenschaften

Label Freitextfeld zur Beschriftung des Nachrichtenflusses (zur übersichtlicheren 
Gestaltung bzw. Dokumentation)

Line 
Routing

Linienführung

Mögliche Werte:

Angled: Angewinkelte Linie

Straight: Gerade Linie (Standard)

Line Type Linienstil

Mögliche Werte:

Dash line: Gestrichelte Linie (Standard)

Solid line: Durchgezogene Linie

Dot line: Gepunktete Linie

Beachten Sie, dass Nachrichtenflüsse ausschließlich zur Visualisierung von logischen 
Zusammenhängen dienen!
Bei der Ausführung des Business Processes über den X4 Server werden ausschließlich 
Prozessbausteine in den Daten- und Kontrollfluss mit einbezogen, die über Sequenzfluss-
Linien verbunden sind, siehe Sequence Flow.


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•

•

•

•

•

•

•

•

•

•

Line Color Farbe des Nachrichtenflusses; Um die Farbe zu ändern, die Eigenschaft markieren 
und auf  klicken.

Mögliche Werte:

 RGB(RRR,GGG,BBB): 24-bit-RGB-Farbcode (über den Farbauswahldialog 
wählbar)

 RGB(0,0,0): Schwarz (Standard)

Line 
Source 
Decorator

und Line 
Target 
Decorator

Symbol für den Linienanfang und das Linienende

Mögliche Werte:

Circle: Kreis/Ellipse (Standard)

Empty arrow: Ungefüllter Pfeil

Association arrow: Offener Pfeil

Arrow: Gefüllter Pfeil

Inverted arrow: Umgekehrter Pfeil

Diamond: Gefüllte Raute

Empty diamond: Ungefüllte Raute

Plain: Kein Symbol

2.5.2 Association

 Association: Logische Verbindung innerhalb eines Business Processes zwischen 
Prozessbausteinen (Events, Gateways oder Activities) und Artefakten (Pools, Data Objects, 
Annotations oder Groups) oder Zeichnungselementen. Dient vor allem zu Dokumentationszwecken.

Eigenschaften

Label Freitextfeld zur Beschriftung der Assoziations-Linie (zur übersichtlicheren 
Gestaltung bzw. Dokumentation)

Beachten Sie, dass Assoziations-Linien ausschließlich zur Visualisierung von logischen 
Zusammenhängen dienen!
Bei der Ausführung des Business Processes über den X4 Server werden ausschließlich 
Prozessbausteine in den Daten- und Kontrollfluss mit einbezogen, die über Sequenzfluss-
Linien verbunden sind, siehe Sequence Flow.


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Line Routing Linienführung

Mögliche Werte:

Angled: Angewinkelte Linie

Straight: Gerade Linie (Standard)

Line Type Linienstil

Mögliche Werte:

Dash line: Gestrichelte Linie (Standard)

Solid line: Durchgezogene Linie

Dot line: Gepunktete Linie

Line Color Farbe der Assoziations-Linie; Um die Farbe zu ändern, die Eigenschaft markieren 
und auf  klicken.

Mögliche Werte:

 RGB(RRR,GGG,BBB): 24-bit-RGB-Farbcode (über den Farbauswahldialog 
wählbar)

 RGB(0,0,0): Schwarz (Standard)

Line Source 
Decorator und 
Line Target 
Decorator

Symbol für den Linienanfang und das Linienende

Mögliche Werte:

Circle: Kreis/Ellipse (Standard)

Empty arrow: Ungefüllter Pfeil

Association arrow: Offener Pfeil

Arrow: Gefüllter Pfeil

Inverted arrow: Umgekehrter Pfeil

Diamond : Gefüllte Raute

Empty diamond: Ungefüllte Raute

Plain : Kein Symbol

2.5.3 Pool/Lane

 Pool/Lane: Gliedert gemäß BPMN 2.0 einen Business Process in Zuständigkeiten und Beteiligte. 
Lanes werden innerhalb eines oder mehrerer sogenannter Pools definiert und repräsentieren somit 
Zuständigkeiten von Aktivitäten. Mit Pools werden die beteiligten Organisationen, Systeme u. a. 
dargestellt, wobei ein Pool beliebig viele Lanes enthalten kann. In der Pool/Lane-Darstellung wird der 
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zeitliche Prozessablauf zumeist von links oben nach rechts unten angeordnet.

Eigenschaften

Pool 
Name

Freitextname des Pools (wenn ein Pool markiert ist)

Lane 
Name

Freitextname der Lane (wenn eine Lane markiert ist)

Line 
Color

Linienfarbe des Pools oder der markierten Lane; Um die Farbe zu ändern, die 
Eigenschaft markieren und auf  klicken.

Mögliche Werte:

RGB(RRR,GGG,BBB): 24-bit-RGB-Farbcode (über den Farbauswahldialog wählbar)

RGB(0,0,0): Schwarz (Standard)

Line 
Width

Linienbreite des Pools oder der markierten Lane in Pixel

Mögliche Werte:

Beliebige positive ganze Zahl

1: 1 Pixel breite Linie (Standard)

Fill 
Color

Füllfarbe des Pools oder der markierten Lane; Um die Farbe zu ändern, die Eigenschaft 
markieren und auf  klicken.

Mögliche Werte:

RGB(RRR,GGG,BBB): 24-bit-RGB-Farbcode (über den Farbauswahldialog wählbar)

RGB(255, 255, 255): Weiß (Standard)

Pools und Lanes in Business Processes verwenden

Mit Pools werden die beteiligten Organisationen, Systeme u. a. dargestellt, wobei ein Pool beliebig 
viele Lanes enthalten kann. In der Pool/Lane-Darstellung wird der zeitliche Prozessablauf zumeist von 
links oben nach rechts unten angeordnet.

Pool einfügen und bearbeiten:

Aus der Palette das Pool-Symbol   per Drag&Drop auf die Zeichnungsfläche ziehen.
Per Klick den Pool verschieben oder durch Ziehen der Eckpunkte beliebig skalieren.
Beschriftung des markierten Pools ändern: In der Properties-Sicht in Pool Name einen 
anderen Text eingeben.
Formatierung ändern: In der Properties-Sicht in Fill Color oder Line Color die 
Füllfarbe oder die Linienfarbe auswählen und auf   klicken, um eine Farbpalette 
aufzurufen.

Lane zu einem Pool hinzufügen:
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Auf einen Pool rechtsklicken und aus dem Kontextmenü Add Lane wählen.
Beschriftung der markierten Lane ändern: In der Properties-Sicht in der 
Eigenschaft Lane Name einen anderen Text eingeben.
Hintergrundfarbe oder Linienfarbe ändern: In der Properties-Sicht die Eigenschaft Fill 
Color bzw. Line Color auswählen und auf   klicken, um eine Farbpalette aufzurufen.

2.5.4 Data Object

 Data Object: Bindet ein beliebiges Daten-Objekt ein, z. B. eine Datei aus dem X4 Repository.

Eigenschaften

Docu
ment

Pfad zum verknüpften Dokument im Repository.

Labe
l

Beschriftung des Symbols im Prozess-Diagramm

Oper
atio
n

Bestimmt, ob die Datei gelesen oder geschrieben werden soll

Mögliche Werte:

Read: Dokument in den Prozess einlesen und Daten an den nächsten Prozess-Schritt 
weitergeben (Standard)

Write: Dokument mit den Daten aus dem vorangegangenen Prozess-Schritt speichern

2.5.5 Data Store

 Data Store: Dient zur Visualisierung einer verwendeten Datenbank.

Eigenschaften

Docu
ment

Pfad zum verknüpften Dokument im Repository.

Labe
l

Beschriftung des Symbols im Prozess-Diagramm

Oper
atio
n

Bestimmt, ob die Datei gelesen oder geschrieben werden soll

Mögliche Werte:

Read: Dokument in den Prozess einlesen und Daten an den nächsten Prozess-Schritt 
weitergeben (Standard)

Write: Dokument mit den Daten aus dem vorangegangenen Prozess-Schritt speichern

Beachten Sie, dass Datenspeicher ausschließlich zur Visualisierung von logischen 
Zusammenhängen dienen!


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2.5.6 Annotation

 Annotation: Fügt eine freie Anmerkung ein, deren Text Sie per Doppelklick in einem 
Dialogfenster bearbeiten und formatieren können.

Eigenschaften

Hyperl
ink

Hinterlegte Verlinkung für die Anmerkung. Zum Verlinken eine gültige URL eintragen.

 Mit Strg+Klick lässt sich die eingetragene URL aufrufen.

Text Textinhalt der freien Anmerkung; Um den Text zu ändern und zu formatieren, die 

Eigenschaft markieren und auf  klicken.

Fill 
Color

Füllfarbe der Anmerkung; Um die Farbe zu ändern, die Eigenschaft markieren und auf 
 klicken.

Mögliche Werte:

RGB(RRR,GGG,BBB): 24-bit-RGB-Farbcode (über den Farbauswahldialog wählbar)

RGB(255, 255, 255): Weiß (Standard)

Transp
arent

Anmerkungsfläche als transparent setzen. Durch Aktivieren der Eigenschaft, wird die 
Eigenschaft Fill Color aufgehoben.

2.5.7 Group

 Group: Fasst Elemente optisch zusammen, um zusammengehörige Gruppen zu visualisieren.

Eigenschaften

Line 
Color

Linienfarbe der Gruppe; um die Farbe zu ändern, die Eigenschaft markieren und auf 

 klicken.

Mögliche Werte:

RGB(RRR,GGG,BBB): 24-bit-RGB-Farbcode (über den Farbauswahldialog wählbar)

RGB(160,160,160): Grau (Standard)

Mit einer Association-Linie können Sie die Annotation mit einem Prozessbaustein logisch 
verbinden.


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Line 
Width

Linienbreite des Gruppenelements

Mögliche Werte:

Beliebige positive ganze Zahl

2: 2 Pixel breite, gestrichtelte Linie (Standard)

2.6 Drawing
Folgende Zeichnungselemente können Sie in sämtlichen Prozesstypen verwenden:

2.6.1 Connection

Connection: Verbindungsbaustein: Gibt den Input aus dem vorangegangenen Prozess-Schritt 
ebenso wie dessen Status unverändert aus. Es markiert den jeweiligen Ausführungszweig für den X4 
Server eindeutig. So lässt sich mit diesem Baustein in Schleifen der Rücksprung zum ersten 
Schleifenbaustein explizit setzen. Es verbindet einen Condition-Baustein mit einem Stop-Baustein 
oder hilft dabei die Positionierung einer Verbindung explizit zu verändern.

2.6.1.1 Eigenschaften

Label Beschriftung des Symbols im Prozess-Diagramm (lässt sich dort auch 
über die F2-Taste bearbeiten)

Beispiele

Connection zwischen Condition und Schleifenrücksprung: Bei Schleifenrücksprüngen wird als 
letzter Schleifenbaustein ein Connection-Baustein gesetzt.
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Connection zwischen Condition und Stop: Zwischen einem Condition-Baustein und 
einem Stop-Baustein wird ein Connection-Baustein gesetzt.

Connection zum Positionieren von Verbindungslinien: Verbindungslinien werden 
normalerweise automatisch positioniert. Um die Positionierung explizit zu verändern, können 
Verbindunsbausteine eingesetzt werden.

2.6.2 Connector

Connector: Ermöglicht die logische Verbindung von beliebigen Elementen.

Eigenschaften

Label Freitextfeld zur Beschriftung der Verbindungslinie (zur übersichtlicheren 
Gestaltung bzw. Dokumentation)

Line Routing Linienführung

Mögliche Werte:

Angled: Angewinkelte Linie

Straight: Gerade Linie (Standard)

Connector-Verbindungslinien ausschließlich zur Visualisierung von logischen 
Zusammenhängen!
Bei der Ausführung über den X4 Server werden ausschließlich Prozessbausteine in den 
Daten- und Kontrollfluss mit einbezogen, die in Business Processes über Sequenzfluss-
Linien, siehe Sequence Flow, bzw. in Technical Processes über Transition-Übergangslinien 
verbunden sind, siehe Transition.





X4 BPM

© SoftProject GmbH 74

•

•

•

•

•

•

•

•

•

•

•

•

•

Line Type Linientyp

Mögliche Werte:

Dash line: Gestrichelte Linie (Standard)

Solid line: Durchgezogene Linie

Dot line: Gepunktete Linie

Line Color Farbe der Verbindungslinie; Um die Farbe zu ändern, die Eigenschaft markieren 

und auf  klicken.

Mögliche Werte:

RGB(RRR,GGG,BBB): 24-bit-RGB-Farbcode (über den Farbauswahldialog 
wählbar)

RGB(0,0,0): Schwarz (Standard)

Line Source 
Decorator und 
Line Target 
Decorator

Symbol für den Linienanfang

Mögliche Werte:

Circle: Kreis (Standard)

Empty arrow: Ungefüllter Pfeil

Association arrow: Offener Pfeil

Arrow: Gefüllter Pfeil

Inverted arrow: Umgekehrter Pfeil

Diamond: Gefüllte Raute

Empty diamond: Ungefüllte Raute

Plain: Kein Symbol

2.6.3 Rectangle und Ellipse

 Rectangle
Zeichnet ein beliebiges Rechteck

 Ellipse
Zeichnet eine beliebige Ellipse

Eigenschaften
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Line Color Rahmenfarbe; um die Farbe zu ändern, die Eigenschaft markieren und auf 
klicken.

Mögliche Werte:

RGB(RRR,GGG,BBB): 24-bit-RGB-Farbcode (über den Farbauswahldialog 
wählbar)

RGB(0,0,0): Schwarz (Standard)

Line Width Linienbreite des Zeichnungselements

Mögliche Werte:

Beliebige positive ganze Zahl

1: 1 Pixel breite Linie (Standard)

Hide Line Rahmenlinie ausblenden

Fill Color Füllfarbe des Zeichnungselements; Um die Farbe zu ändern, die Eigenschaft 
markieren und auf   klicken.

Mögliche Werte:

RGB(RRR,GGG,BBB): 24-bit-RGB-Farbcode (über den Farbauswahldialog 
wählbar)

RGB(255, 255, 255): Weiß (Standard)

Transparent Zeichnungselements als transparent kennzeichnen. Durch Aktivieren der 
Eigenschaft, wird die Eigenschaft Fill Color aufgehoben.

2.6.4 Textbox

 Textbox: Fügt einen Textrahmen ein, dessen Inhalt Sie per Doppelklick in einem Dialogfenster 
bearbeiten und formatieren können.

Eigenschaften

Hyperlink Hinterlegte Verlinkung für das Textfeld. Zum Verlinken eine gültige URL eintragen.
 Mit Strg + Klick lässt sich die eingetragene URL aufrufen.

Text Inhalt des Textrahmens; um den Text zu ändern und zu formatieren, die Eigenschaft 
markieren und auf  klicken.
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Rotation Drehung des Textrahmens

Mögliche Werte:

0: Keine Drehung (Standard)

90: Um 90° gegen den Uhrzeigersinn drehen

180: Um 180° drehen

270: Um 270° gegen den Uhrzeigersinn drehen

Fill Color Füllfarbe des Textfeldes; Um die Farbe zu ändern, die Eigenschaft markieren und auf 
 klicken.

Mögliche Werte:

RGB(RRR,GGG,BBB): 24-bit-RGB-Farbcode (über den Farbauswahldialog wählbar)

RGB(255, 255, 255): Weiß (Standard)

Transparen
t

Textfeld als transparent setzen. Durch Aktivieren der Eigenschaft, wird die 
Eigenschaft Fill Color aufgehoben.

2.6.5 Polygon

Polygon: Zeichnet ein Polygon mit beliebig vielen Eckpunkten.

Eigenschaften

Line Color Rahmenfarbe; um die Farbe zu ändern, die Eigenschaft markieren und auf 
klicken.

Mögliche Werte:

RGB(RRR,GGG,BBB): 24-bit-RGB-Farbcode (über den Farbauswahldialog 
wählbar)

RGB(0,0,0): Schwarz (Standard)

Line Width Linienbreite des Zeichnungselements

Mögliche Werte:

Beliebige positive ganze Zahl

1: 1 Pixel breite Linie (Standard)
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Fill Color Füllfarbe des Zeichnungselements; um die Farbe zu ändern, die Eigenschaft 

markieren und auf  klicken.

Mögliche Werte:

RGB(RRR,GGG,BBB): 24-bit-RGB-Farbcode (über den Farbauswahldialog 
wählbar)

RGB(255,255,255): Weiß (Standard)

Transparent Transparente Füllung (keine Füllfarbe verwenden). Durch Aktivieren der 
Eigenschaft, wird die Eigenschaft Fill Color aufgehoben.

2.6.6 Polyline und Line

 
Polyline

Zeichnet eine Linie mit beliebig vielen Wegpunkten

 Line
Zeichnet eine gerade Linie

Eigenschaften

Line 
Color

Linienfarbe; um die Farbe zu ändern, die Eigenschaft markieren und auf 

 klicken.

Mögliche Werte:

RGB(RRR,GGG,BBB): 24-bit-RGB-Farbcode (über den Farbauswahldialog wählbar)

RGB(0,0,0): Schwarz (Standard)

Line 
Width

Linienbreite des Zeichnungselements

Mögliche Werte:

Beliebige positive ganze Zahl

1: 1 Pixel breite Linie (Standard)

2.6.7 Image

 Image: Fügt einen Bildrahmen ein, mit dem sich eine Grafikdatei vom Typ .gif, .jpg, .png 
oder .bmp einbinden lässt.
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Eigenschaften

Line 
Color

Linienfarbe des Bildrahmens; Um die Farbe zu ändern, die Eigenschaft markieren und 

auf   klicken.

Mögliche Werte:

RGB(RRR,GGG,BBB): 24-bit-RGB-Farbcode (über den Farbauswahldialog wählbar)

RGB(0,0,0): Schwarz (Standard)

Line 
Width

Linienbreite des Zeichnungselements

Mögliche Werte:

Beliebige positive ganze Zahl

1: 1 Pixel breite Linie (Standard)

Image 
File

Pfad der verknüpften Grafikdatei

Das eingefügte Bild wird im Prozess gespeichert.
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3 Mit BPM-Projekten arbeiten
Das X4 Repository ist in Projekten organisiert. Projekte besitzen eine Dateisystem-Struktur und 
können beliebige Ordner, Prozesse, Prozessbausteine und andere Dateien enthalten.

3.1 Die Struktur von BPM-Projekten
BPM-Projekte haben eine vordefinierte und nicht veränderbare Ordnerstruktur, die beim Anlegen 
eines neuen BPM-Projektes automatisch angelegt wird. 

Projekt Auf oberster Ebene des Projektes lassen sich 
Prozesslandkarten (.pld) erstellen.

Processes Innerhalb des Processes-Ordners können beliebig viele BPM-
Prozesse (.bpm) angelegt werden. Hier ist ebenfalls der 
Activities-Ordner mit seiner vordefinierten Struktur enthalten.

Activities Der Activities-Ordner enthält folgende Unterordner, die jeweils 
nur vordefinierte Dateien enthalten dürfen:

Adapters: Hier können lediglich Ordner und Adapter-
Dateien vom Typ .fa und .tra angelegt werden
DomainModel: Hier können beliebig viele .domainmodel-Da
teien angelegt werden, in denen Vorgangs-Fachdaten 
definiert werden
Processes: Hier können technische Prozesse (.wrf) zur 
Verknüpfung mit den Aktivitäten abgelegt werden
Resources: Hier können Ressourcen wie Bilder, Text- und 
XML-Dokumente sowie weitere Dateien abgelegt werden
TemporaryFiles: Hier können temporäre Dateien wie Text- 
und XML-Dokumente abgelegt werden
Transformations: Hier können Transformationen (.xsl) 
sowie Reports (.rep) abgelegt werden

Resources Hier können neben Ordnern auch Ressourcen wie Bilder, Text- und 
XML-Dokumente sowie weitere Dateien abgelegt werden.

3.2 BPM-Projekt anlegen

Die automatisch angelegten Ordner und Unterordner können nicht gelöscht, verschoben oder 
umbenannt werden.



•
•
•

BPM-Projekte lassen sich auf verschiedene Arten anlegen:

Über New BPM Project auf der Welcome-Seite des X4 Designers
Über das Kontextmenü New > BPM Project im Repository Navigator
Über das Menü File > New > BPM Project





X4 BPM

© SoftProject GmbH 80

1.

2.
3.
4.

Im X4 Designer Menü File > New> BPM Project wählen.

Leere Projektvorlage oder eine vorhandene Projektvorlage wählen.
In Project name den Namen des Projekts eingeben.
Finish klicken, um das Projekt anzulegen.
Ein leeres BPM-Projekt mit der vordefinierten Struktur wird im Repository Navigator angelegt.

3.3 Templates
Im X4 Designer stehen Ihnen verschiedene Templates beim Erstellen eines Projects zur Auswahl.

3.3.1 ESB Project
Kategorie Template Beschreibung
Basics ESB Introduction Dieses Projekt enthält eine kurze Einführung in 

die Modellierung Technical Processes.
XSLT Introduction Dieses Projekt enthält eine kurze Einführung in 

die Erstellung von XML-Datentransformationen.
Database Create Data Dieses Projekt enthält ein Beispiel für die 

Erstellung von Daten in einer Datenbank unter 
Verwendung des JDBC Connector Adapters.

Delete Data Dieses Projekt enthält ein Beispiel für das 
Löschen von Daten aus einer Datenbank unter 
Verwendung des JDBC Connector Adapters.

Read Data Dieses Projekt enthält ein Beispiel für das Lesen 
von Daten aus einer Datenbank unter 
Verwendung des JDBC Connector Adapters.

Über das Kontextmenü können nun die verschiedenen Elemente eines BPM-Projektes 
angelegt werden. Die verfügbaren Optionen ändern sich je nachdem an welcher Stelle 
in der Baumstruktur das Kontextmenü aufgerufen wird.


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Update Data Dieses Projekt enthält ein Beispiel für die 
Aktualisierung von Daten in einer Datenbank 
unter Verwendung des JDBC Connector 
Adapters.

E-Mail Send e-mails with the POP/
SMTP adapter

Dieses Projekt enthält ein Beispiel für das 
Versenden von E-Mails unter Verwendung des 
POP/SMTP-Adapters.

3.3.2 BPM Project
Kategorie Template Beschreibung
Basics BPMN Introduction Dieses Projekt enthält eine kurze Einführung in 

die Modellierung von Business Processes.
Demos Approve electronic invoice Diese Demo enthält einen Genehmigungsprozess 

für elektronische Rechnungen. Es umfasst 
Business Processes, Geschäftsregeln (DMN) und 
Human Tasks.

3.3.3 Web App Project
Kategorie Template Beschreibung
Components Calendar Component Diese Web App ist ein Beispiel für eine Calendar 

Component mit Terminen.
Grid Component Diese Web App ist ein Beispiel für die Anzeige von 

Daten in tabellarischer Form in der Grid 
Component.

Controls How to use Controls Dieses Projekt enthält Beispiele für die 
Verwendung der gängigsten Controls in X4 Web 
Apps.

TextBlock Dieses Projekt enthält Beispiele für die 
Verwendung des TextBlock Controls in X4 Web 
Apps.

Demos Manage your customer data In dieser Demo können Sie Ihre Kunden, deren 
Adressdaten sowie Ansprechpartner verwalten.

Report a street lighting 
malfunction

In dieser Demo kann ein Kunde eine Störung im 
Straßenbeleuchtungssystem melden. Die Daten 
werden in einer Datenbank gespeichert.

Layouts How to use layouts Dieses Projekt enthält Beispiele für die 
Verwendung von Layouts in X4 Web Apps.

Properties Data Context Dieses Projekt enthält ein Beispiel für die 
Verwendung von Properties desselben Kontexts 
in mehreren Components.

3.4 Prozesslandkarten modellieren
Mit einer Prozesslandkarte (Process Landscape) können Sie Prozesslandschaften im X4 Designer
übersichtlich darstellen und beliebige Prozesse und andere Dokumente verknüpfen.
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Alle relevanten Prozesse können Sie hier grafisch darstellen und der logische Zusammenhangs von 
Prozessen lässt sich kompakt dokumentieren. Eine so erstellte Prozesslandkarte bietet somit eine 
übergeordnete Sicht auf Führungs-, Wertschöpfungs- und Unterstützungsprozesse und bilden die 
Grundlage für das Qualitätsmanagement.

Prozesslandkarten werden auf oberster Ebene eines BPM-Projektes angelegt. Jedes BPM-Projekt 
darf nur eine Prozesslandkarte erhalten, welche den Projektnamen als Namen trägt, z. B. 
Demoprojekt.pld. Prozesslandkarten sind nicht ausführbar, sondern dienen lediglich der Übersicht 
über Business Processes, die sich in Block Arrow-Elementen verknüpfen lassen. Zudem können Sie 
über Data Objects beliebige weitere Repository-Dateien verknüpfen.

3.5 Business Process erstellen
Mit dem BPMN Editor können Sie fachliche Business Processes gemäß BPMN 2.0 modellieren. 
Sie können sowohl leere Aktivitäten aus der Palette als auch Dateien aus dem Repository auf die 
Zeichnungsfläche ziehen und in der Properties-Sicht deren jeweiligen Eigenschaften konfigurieren, 
um einen ausführbaren Business Process zu erstellen.

Im Free-flow-Modus besteht zudem die Möglichkeit, den BPMN Editor als reines BPMN-
Zeichenwerkzeug mit einer erweiterten BPMN-Palette zu verwenden, wobei die Run/Debug-
Funktion deaktiviert ist.


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1.

2.
3.

4.

5.

6.
7.

8.

9.

Innerhalb des Ordners Processes z.B. über das Kontextmenü New > Business Process einen 
neuen Business Process erstellen.

Leere Projektvorlage oder eine vorhandene Projektvorlage wählen.
In File name den Namen des Business Processes eingeben.

 Leerzeichen und Umlaute sind hierbei nicht erlaubt! 
Next klicken, um weitere Prozessinformationen einzugeben.

In Process title einen Prozesstitel eingeben.
Der Prozessestitel wird im Prozessdiagramm angezeigt und kann in der Properties-Sicht über 
die Eigenschaft Title verändert und bei Bedarf über Eigenschaft Show Title ein- und 
ausgeblendet werden. 
Unter Process description ggf. eine Prozessbeschreibung hinterlegen.
Unter Free-flow mode ggf. den Free-flow-Modus für Geschäftsrozesse aktivieren und den BPM 
Designer als reines BPMN-Zeichen-Werkzeug mit einer erweiterten BPM-Palette verwenden.

 Im Free-flow-Modus ist die Run/Debug-Funktion deaktiviert.
Finish klicken, um den Business Process anzulegen.
Ein leerer Business Process wird unter der Dateinamensendung .bpm im Repository 
gespeichert und im BPMN Designer geöffnet. 
Business Process wie gewünscht modellieren:
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•

Sequence Flow-Verbindungslinien erstellen:
Mit dem Mauszeiger über das Start-Symbol fahren, um einen kleinen Pfeil 
anzuzeigen.
Pfeil anklicken und zum End-Symbol ziehen, um einen Sequence 
Flow herzustellen.

Symbole aus der Palette oder dem Repository Navigator per Drag&Drop auf die 
Verbindungslinie ziehen.

Pools und Swimlanes einfügen, siehe Pool/Lane
Event-Elemente einfügen, siehe Events.
Parallel Gateway-Elemente oder Exclusive Gateway-Elemente einfügen, 
siehe Gateways.

3.5.1 Nutzung von Private Files unterhalb von Business Processes
Wenn Prozessressourcen nur innerhalb eines Business Processes verwendet werden sollen, lassen 
sich diese direkt unterhalb eines Elternprozesses anlegen. Damit können sie ausschließlich im 
Prozesskontext verwendet werden und lassen sich aus anderen Business Processes auch nicht 
aufrufen.

Grundsätzlich lassen sich unterhalb eines einzelnen Business Processes die gleichen Ressourcen 
anlegen wie innerhalb eines BPM-Projektes – seien es weitere Business Processes (.bpm), 
Technical Processes (.wrf), Human Tasks (.humantask), Rules (.rule) oder Domain Models 
(.domainmodel). 

Tipp
Über das Menü Project > Validate Project lässt sich der Business Process über 
einen integrierten Prozess-Validator auf Gültigkeit prüfen.
Wenn Sie Dateien aus dem Repository in Ihren Prozess einbinden und diese in 
der Properties-Sicht entsprechend konfigurieren, können Sie den modellierten 
Prozess über  ausführen. Ausgenommen sind Prozesse im Free-flow-Modus.


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3.6 Business Process im BPMN- oder XML-Format importieren
Mit dem BPMN 2.0 Import Wizard lassen sich Prozessdiagramme aus anderen 
Modellierungswerkzeugen, die im Format .xml oder .bpmn vorliegen, als neue Business Processes ins 
X4 Repository importieren.

Über das Menü Project > Import BPMN 2.0 Process den BPMN 2.0 Import Wizard öffnen.

Browse klicken, um die gewünschte Datei zu wählen.

Die Datei auswählen und mit Öffnen bestätigen.
Die Datei wird nun im Wizard ausgewählt.

Die zu verwendenden Ressourcen können sowohl über das Kontextmenü New > 
<Ressourcenname> als auch über die Symbolleiste  > Add <Ressourcenname> angelegt 
werden. 
Die angelegten Ressourcen lassen sich anschließend wie gewohnt parametrieren und per 
Drag & Drop aus dem Repository in das Prozessdiagramm einbauen, siehe auch Human 
Task, Rule, Vorgangs-Fachdaten verwalten.



Sie können anhand der Endung .xml (Standard) oder .bpmn nach der Datei filtern.
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•

•

Finish klicken, um die Datei zu importieren.
Die Datei wurde nun importiert und wird als Business Process im Repository Navigator 
angezeigt.

3.7 Eigenschaften von Business Processes (.bpm)
Business Processes (.bpm) werden über den BPMN Editor grafisch modelliert und können auf dem X4 
BPM Server ausgeführt werden, wenn sämtliche Bausteine entsprechend parametriert und korrekt 
mit Repository-Dateien verknüpft wurden.

Eigenschaften

Documentation
Created Erstelldatum des Prozesses
Created by Name des Prozess-Erstellers
Last Update Datum der letzten Änderung  
Last Update by Name des letzten Bearbeiters 
Title Freitextfeld für den Prozesstitel

Version Projektversion

 Wenn keine Version gesetzt ist, wird der Zeitstempel als Version genommen.

Technical
Can Stop Geschäftsprozess darf während der Ausführung angehalten werden

 Diese Eigenschaft wird nicht an Subprozesse vererbt.

Mögliche Werte:

True: für normale Prozesse (Standard)

False: für kritische Prozesse, die zu Ende laufen müssen

•

•

Die Eigenschaften jedes Business Processes lassen sich in der Properties-Sicht des BPMN 
Editors bearbeiten, wenn im BPMN Editor ein freier Bereich der Zeichnungsfläche angeklickt 
wird.
Standardmäßig werden die gebräuchlichsten Eigenschaften angezeigt, über die Symbolleiste 
der Properties-Sicht lassen sich jedoch zusätzliche Einstellungen vornehmen:

 Show Categories: Eigenschaften nach Kategorien geordnet anzeigen

 Show Advanced Properties: Erweiterte Eigenschaften anzeigen


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Free-flow mode Zeigt an, ob der Free-flow-Modus aktiviert ist. Dabei wird die erweiterte 
BPMN-Palette freigeschaltet, um den BPMN Editor als reines BPMN-Zeichen-
Werkzeug zu verwenden.

In service Prozess aktiv oder inaktiv setzen. Werden inaktive Prozesse direkt ausgeführt, 
so erhalten sie die Prozess-ID -1 . Subprozesse, also Prozesse, die in anderen 
Prozessen aufgerufen werden, können unabhängig von dieser Eigenschaft 
immer ausgeführt werden.

Mögliche Werte:

True: Prozess kann ausgeführt werden (Standard)

False: Prozess kann nicht ausgeführt werden (nur als Subprozess)

Instance limit Maximale Anzahl von Instanzen dieses Prozesses, die parallel ausgeführt werden 
dürfen.

Schedule Schedule-Werkzeug, das zeitgesteuertes Ausführen von Prozessen auf dem X4 
Server ohne X4 Designer ermöglicht; um einen Zeitplan einzurichten, die 
Eigenschaft markieren und auf  klicken.

Mögliche Werte:

Disabled: Kein Zeitplan wurde festgelegt (Standard)

Enabled: Ein Zeitplan für die Ausführung des Prozesses wurde hinterlegt

Stop on error Im Fehlerfall die Prozess-Ausführung anhalten

Mögliche Werte:

True: Prozess-Ausführung abbrechen, wenn ein Fehler auftritt (Standard)

False: Prozess-Ausführung nicht abbrechen, wenn ein Fehler auftritt 
(sofern möglich)

Schema 
Declaration

Schema für Input und Output des Prozesses

•

•

Diese Option kann beim Anlegen des Business Processes aktiviert 
werden und nicht nachträglich geändert werden.
Im Free-flow-Modus ist die Run/Debug-Funktion für den aktuellen 
Business Process deaktiviert.



Beachten Sie!

Instance limit wird ignoriert, wenn der Prozesse als Subprozess 
aufgerufen wird.


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3.8 Prozesskomponenten ausrichten
Prozessbausteine lassen sich über den Kontextmenü-Eintrag Layout auf einfache Weise aneinander 
ausrichten. Damit lässt sich schnell und einfach eine saubere, strukturierte Darstellung generieren. 

Dazu die gewünschten Prozesskomponenten auswählen und über Rechtsklick das Kontextmenü 
aufrufen. Anschließend Layout und die gewünschte Option wählen.

Folgende Optionen stehen für das Ausrichten der Prozesskomponenten zur Verfügung

Align Horizontal: Komponenten anhand des Mittelwertes horizontal ausrichten
Align Vertical: Komponenten anhand des Mittelwertes vertikal ausrichten
Distribute Horizontal: Komponenten gleichmäßig horizontal verteilen
Distribute Vertical: Komponenten gleichmäßig vertikal verteilen

 

3.9 Prozess-Metadaten hinzufügen
Bei Bedarf können Sie beliebig viele weitere Metadaten zur Prozessdefinition eines Technical 
Processes oder Business Processes hinzufügen und bearbeiten, z.B. für Dokumentationszwecke.

Im Prozess Editor auf einen leeren Bereich der Zeichnungsfläche klicken, um in der Properties-
Sicht die Prozesseigenschaften anzuzeigen.

Die Eigenschaft Metadata > Manage Metadata wählen und auf 
 klicken.

Für die Optionen Align Horizontal und Align Vertical müssen mindestens zwei 
Prozesskomponenten ausgewählt sein, für die Optionen Distribute 
Horizontal und Distribute Vertical mindestens drei Komponenten.


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Ein Dialog wird geöffnet, in dem Sie beliebige Schlüssel/Wert-Paare definieren können.

Metadaten-Eigenschaften eingeben:
In Name den Name des Metadatums eingeben, z.B. Version.
In Value den entsprechenden Wert eingeben, z.B 1.1.

Um die Reihenfolge eines selektierten Metadatums zu ändern, auf Up oder Down klicken.
OK klicken, um die Einstellungen zu speichern.
Das Metadatum wurde nun hinzugefügt und wird in der Properties-Sicht angezeigt. In der 
Prozessdefinitionsdatei werden die Metadaten im XML-Speicherformat abgelegt.

3.10 Projekte importieren
Hier erfahren Sie, wie Sie Projekte sowie verschiedene Ressorcen aus dem lokalen Dateisystem ins 
Repository importieren.

3.10.1 Importieren via Drag&Drop
Aus dem Dateisystem (z. B. vom Desktop oder dem Windows Explorer) können Sie eine oder mehrere 
markierte Dateien per Drag & Drop in den Repository Navigator und damit ins aktuell verbundene 
Repository importieren. Falls eine Datei gleichen Namens am Ziel bereits vorhanden ist, werden Sie 
aufgefordert, einen neuen Namen einzugeben.

Über Schaltfläche Remove können Sie ein selektiertes Metadatum löschen.
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3.10.2 Import Wizard für Dateien und Projekte nutzen

Menü Projekt > Import aufrufen.
Der Resource Import Wizard wird aufgerufen.
Resource auswählen.

Über Browse die zu importierende Datei (*.zip) oder das zu importierende Projekt 
wählen und in New project/file name den entsprechenden Namen eingeben.

Finish klicken.

3.11 Projekte exportieren
Hier erfahren Sie, wie Sie Projekte sowie verschiedene Ressorcen aus dem Repository ins 
Dateisystem exportieren.

3.11.1 Export Wizard für Dateien und Projekte nutzen

•

•

•

•

Beachten Sie:
Ordnerstrukturen werden beim Import nicht unterstützt, verwenden Sie hierzu den 
entsprechenden Wizard.
Bei größeren Dateiübertragungen (insgesamt über 1 MB) wird ein Bestätigungsdialog 
eingeblendet, da möglicherweise Verzögerungen bei der Übertragung sowie 
Arbeitsspeicher-Probleme auftreten können.
Importierte Dateien, die Sonder-/Leerzeichen oder Umlaute im Dateinamen enthalten, 
müssen zunächst umbenannt werden, bevor Sie diese im X4 Designer öffnen können.
Projekte verfügen über eine vordefinierte Struktur, sodass die eingefügten Dateien nur 
im jeweils vordefinierten Ordner abgelegt werden können, siehe auch Die Struktur von 
ESB-Projekten



•

•

Beachten Sie
Projekte verfügen über eine vordefinierte Struktur, sodass die zu importierenden 
Dateien nur im jeweils vordefinierten Ordner abgelegt werden können, siehe auch Die 
Struktur von ESB-Projekten
Projekte können lediglich auf oberster Ebene und in der vordefinierten Projektstruktur 
importiert werden, siehe auch Die Struktur von ESB-Projekten



•

Beachten Sie
Projekte können nur dann exportiert werden, wenn die oberste Projektebene 
ausgewählt ist.


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Menü Projekt > Export aufrufen.
Der Resource Export Wizard wird aufgerufen.
Zielordner auswählen.
Speichern klicken.
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4 Case Management
Mit dem Case Management im X4 Designer können Sie vorgangsbezogene Abläufe mitsamt 
Fachdaten, Fachstatus und fallbezogenen Aufgaben abbilden.

Definieren Sie Fachdaten und Fachstatus direkt in den Business Processes – so modellieren Sie nicht 
nur den Ablauf, sondern definieren gleichzeitig auch ein Prozessdatenmodell, mit dem Sie komplexe 
Vorgänge abbilden können, z. B. spezifische Freigabeprozesse oder Prozesse, die verschiedene 
Status durchlaufen.

Hinterlegen Sie Kategorien, Gruppen und Merkmale, um Ihre Fachdaten abzubilden. Fachdaten, wie 
Rechnungsnummern können direkt zur Laufzeit im Prozess hinterlegt und Geschäftsregeln auf deren 
Basis definiert werden.

Geben Sie verschiedene Fachstatus direkt bei der Modellierung der Business Processes an. Die 
definierten Status können in den erstellten BPMN-Diagrammen über Ereigniselemente, 
Entscheidungstabellen, Gateway-Elemente oder Human Tasks ausgewertet bzw. gesetzt werden.

4.1 Vorgänge und Workflows realisieren
Menschen lassen sich in Business Processes typischerweise über Aufgaben einbinden. Bei der 
Modellierung von Business Processes passiert dies über einen Human Task.

Läuft ein Business Process während der Ausführung auf einen Human Task, wird die Ausführung des 
Business Processes angehalten und die menschlichen Aufgabe generiert. Der Prozess wartet auf die 
notwendige menschliche Interaktion und setzt die Ausführung fort, sobald die menschliche Aufgabe 
zu dem Prozess abgeschlossen ist.

Anhand des folgenden Beispiels soll die typische Umsetzung mit der X4 BPMS dargestellt werden.

Business Process wie gewünscht modellieren.
Im Beispiel wird ein Freigabeprozess dargestellt, bei dem je nach freizugebenden Betrag 
entweder eine automatische Freigabe oder eine Freigabe durch verschiedene 

Mit der Version 7.0 der X4 BPMS wurde die Art und Weise, wie Vorgänge und Workflows mit 
Case Management realisiert werden, umgestellt. Wenn Sie von einer Version 6.x auf eine 7.0 
aktualisieren, werden vorhandene Prozesse automatisch migriert.


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Prozessbeteiligte erfolgt.

Die entsprechenden Fachstatus und Fachdaten definieren:
Zum Definieren des Fachstatus (.state), siehe Vorgangs-Statuswerte verwalten.

Zum Definieren der Fachdaten (.domainmodel), siehe Vorgangs-Fachdaten verwalten.

Über eine Aktivität werden die Daten eingelesen. Die Aktivität ist mit einem technischen 
Prozess verknüpft, der die Daten ausliest und den über den Case Management Adapter alle 
Features (Merkmale) ausgibt. 
Über ein Intermediate wird der Status des Vorgangs gesetzt. 
Hierzu stehen in der Eigenschaft Case State des Intermediate Events alle prozessweit 
definierten Vorgangs-Statuswerte zur Auswahl zur Verfügung.
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Über Entscheidungstabellen (.rule) werden die Regeln hinterlegt, um die Aufgabe je nach Höhe 
des Betrags der entsprechenden Person zuzuweisen. Im Input wird dabei angegeben, woher die 
zu prüfenden Daten kommen. Über Case Feature werden die zuvor definierten Merkmale 
(siehe Vorgangs-Fachdaten verwalten) angegeben. 

Mit einem Condition-Baustein werden die verschiedenen Ausführungszweige abgebildet. Im 
Condition Editor können die Vorgangszustände des aktuellen Business Processes als 
Auswertungskriterium für die Bedingungen verwendet werden, siehe Bedingungen erstellen 

Mit Entscheidungstabellen lassen sich auch Variablen, Features, Benutzerdefinierte 
Platzhalter oder Statuswerte (Case State) auswerten. Dazu lassen sich mit Strg + 
Leertaste im Regel-Bereich alle aktuell verfügbaren Variablen (v:Variablenname),  
Features (f:Featurename), Benutzerdefinierten Platzhalter (p:Platzhaltername) und 
Vorgangs-Statuswerte (c:CaseState) in einer Auswahlliste aufrufen.


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und verwenden.

Für jeden Ausführungszweig den entsprechenden Prozessschritt konfigurieren. Bei Bedarf 
muss der Human Task und damit die Funktionen der Task Management Web App konfiguriert 
werden.
Prozess speichern und ausführen.
Die Task Management Web App über das Menü Tools > X4 Task Management öffnen.
In der Task Management Web App einloggen. 
Die zu bearbeitenden Vorgänge werden nun angezeigt.

Vorgänge wie gewünscht bearbeiten.

4.2 Vorgangs-Fachdaten verwalten
Um Vorgänge mit X4 BPM abzubilden, ist es erforderlich, die benötigte Struktur der Fachdaten für den 
Business Process zu definieren. Über Domain-Model-Dateien (.domainmodel) können Sie eine 
dreistufige Hierarchie mit Fachdatenstrukturen inklusive der zugehörigen Beschreibung definieren 
und somit der Prozessdefinition hinzufügen.

Welcher Benutzer einen Vorgang bearbeiten darf, wird über den Rule-Baustein 
ausgewertet.



Welche Bearbeitungsfunktionen verfügbar sind, hängt von der Konfiguration im Human 
Task ab.


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4.2.1 Aufbau von Vorgangs-Fachdaten
Fachdaten eines Vorgangs werden in Kategorien, Gruppen und Merkmale untergliedert: 

Kategorien gruppieren Fachdaten auf höchster Ebene und enthalten Gruppen. Jede Kategorie 
besitzt einen Namen, eine Position und eine optionale Beschreibung.
Gruppen fassen Merkmale von Fachdaten innerhalb einer Kategorie zusammen. Jede Gruppe 
besitzt einen Namen, eine Position und eine optionale Beschreibung.
Merkmale sind die konkreten Eigenschaften der Vorgangs-Fachdaten, z.B. ein Auftragsdatum 
innerhalb einer Merkmals-Gruppe. Jedes Merkmal besitzt einen im Domain-Model eindeutigen 
Namen, eine Position, eine optionale Beschreibung, einen Datentyp sowie einen optionalen 
Standardwert.

Verfügbare Datentypen für Merkmale sind:

String: Zeichenkette
Integer: Ganzzahl 
Decimal: Fließkommazahl
Boolean: Boolescher Wert
DateTime: Datum und Uhrzeit

4.2.2 Vorgangs-Fachdaten definieren
Vorgangs-Fachdaten lassen sich sowohl für einzelne Geschäftsprozesse als auch für das gesamte 
Projekt bzw. mehrere Geschäftsprozesse definieren. 

Die .bpm-Datei in der Repository Navigator-Sicht rechtsklicken.
Im Kontextmenü New > Domain Model wählen.

•

•

Gelten die Vorgangs-Fachdaten für mehrere Business Processes, wird die 
entsprechende .domainmodel-Datei im Repository-Ordner Activities > 
DomainModel angelegt.
Gelten die Vorgangs-Fachdaten nur für einen bestimmten Business Process, 
wird die entsprechende .domainmodel-Datei direkt unterhalb des Business 
Processes angelegt. Nach dem Speichern wird diese direkt an den Start-Bauste
in des Business Processes angehängt. 


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Die Datei wird nun angelegt und im X4 Designer geöffnet.

Struktur der Fachdaten und deren Beschreibung definieren:
Um eine neue Merkmalskategorie (Category) zu definieren, auf Add klicken oder   Add > 
Category wählen. Anschließend einen Namen (Name) und eine Beschreibung 
(Description) eingeben.
Um eine Merkmals-Gruppe (Group)zu definieren, innerhalb einer Kategorie 
auf Add klicken oder über   Add > Group wählen. Anschließend einen Namen (Name) 
und eine Beschreibung (Description) eingeben.
Um ein Merkmal (Feature) zu definieren, innerhalb einer Merkmals-Gruppe 
auf Add klicken oder über   Add > Feature wählen. Anschließend einen Namen (Name), 
eine Beschreibung (Description), den Datentyp (Type) für das Merkmal sowie einen 
Standardwert (Default Value) eingeben.
Beispiel:
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In der Symbolleiste das  -Symbol anklicken, um zu speichern.
.domainmodel-Datei anschließend in den gewünschten Business Process ziehen. 

4.3 Vorgangs-Statuswerte verwalten
Um Vorgänge mit X4 BPM abzubilden, ist es erforderlich, die benötigten Statuswerte des Business 
Processes zu definieren. Statuswerte und Statusbeschreibungen werden in einer separaten Datei (.s
tate) definiert.

4.3.1 Vorgangs-Statuswerte hinzufügen

Die .bpm-Datei in der Repository Navigator-Sicht rechtsklicken.

•

•

Um die Reihenfolge eines selektierten Elements zu ändern, auf   oder 

 klicken.
Über Schaltfläche Delete können Sie einen in der Baumstruktur 
selektierten Eintrag löschen.



.domainmodel-Dateien, die unterhalb des Business Processes angelegt werden, 
werden automatisch an den Start-Baustein angehängt. Die Fachdaten stehen somit 
im Prozess und den enthaltenen Human Tasks zur Verfügung.


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Im Kontextmenü New > Case States wählen.
Eine neue .state-Datei wird angelegt und geöffnet.

Auf Add klicken, um einen neuen Status zu definieren:
In Name den Name des Status eingeben, z.B. Approved.
In Description eine zugehörige Beschreibung eingeben (optional).

Um die Reihenfolge eines selektierten Statuswerts zu ändern, auf   oder   klicken.
Datei speichern.

4.4 Task Management Web App
Über Human Tasks lassen sich Menschen in Business Processes einbinden. Die Task Management 
Web App bietet die entsprechende Oberfläche zur Abarbeitung der definierten Aufgaben. 

Die Task Management Web App besitzt bereits eine vordefinierte Struktur und vordefinierte 
Funktionen. Innerhalb des entsprechenden Business Process und über verschiedene Einstellungen 
im Human Task Editor lassen sich jedoch weitere Einstellungen vornehmen.  

Über Schaltfläche Delete können Sie einen selektierten Statuswert löschen.

Vorgangs-Status mit Intermediate Events setzen
Den Status eines Vorgangs, der zur Laufzeit des aktuellen Business Processes bearbeitet 
werden soll, können Sie auch mit Intermediate Events setzen. Hierzu stehen in 
Eigenschaft Case Management > Case State des Intermediate Events alle prozessweit 
definierten Vorgangs-Statuswerte zur Auswahl.


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4.4.1 Fachdaten definieren und anzeigen
Fachdaten werden über die Eigenschaft Business Data des Business Processes definiert, siehe 
Vorgangs-Fachdaten verwalten. Welche der definierten Fachdaten für den Benutzer in der Task 
Management Web App tatsächlich angezeigt werden, wird über den Human Task Editor, innerhalb der 
Registerkarte Business Data angegeben.

Die Task Management Web App lässt sich über das Menü Tools > X4 Task 
Management öffnen. Die Standard-Zugangsdaten sind demo/demo.


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4.4.2 Status definieren und setzen
Statuswerte werden über die Eigenschaft Case States des Business Processes definiert, siehe 
Vorgangs-Statuswerte verwalten. Welche der definierten Status ein Benutzer in der Task 
Management Web App für seine Vorgänge tatsächlich setzen kann, wird über den Human Task Editor, 
innerhalb der Registerkarte Actions angegeben. 
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4.4.3 Vorgänge ablehnen, weiterleiten und auf Wiedervorlage setzen
Ob der Bearbeiter die Möglichkeit haben soll, Vorgänge abzulehnen, weiterzuleiten oder auf 
Wiedervorlage zu setzen, kann im Human Task Editor, innerhalb der Registerkarte Settings definiert 
werden.

4.4.4 Dokumente anzeigen und bearbeiten
Ob Dokumente in der Task Management Web App angezeigt und ggf. bearbeitet werden sollen, wird 
im Human Task Editor, innerhalb der Registerkarte Settings definiert.

Mit Enable Documents werden die Registerkarte Dokumente sowie die Schaltfläche 
Herunterladen in der Task Management Web App eingeblendet.  
Über Documents can be added/edited können Dokumente bearbeitet (Schaltfläche 
Hochladen) und hinzugefügt (Schaltfläche Neues Dokument) werden.  
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4.4.5 Fälligkeitsmanagement für Vorgängen
Für jeden Vorgang kann eine Fälligkeit definiert werden. Diese wird innerhalb des Human Task 
Editors unter General > Deadline angegeben. Neben einer Frist (Duration) kann auch eine genaue 
Fälligkeit (Until) mit Datum und Uhrzeit definiert werden. Zudem kann über Case State ein Status 
angegeben werden, der automatisch ausgeführt wird, wenn die Frist des Vorgangs erreicht wurde.
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Ist die Fälligkeit des Vorgangs eingetreten, bevor er bearbeitet werden konnte und der Prozess wurde 
automatisch mit einem konfigurierten Case State fortgesetzt, wird der Vorgang automatisch 
geschlossen und innerhalb der Task Management Web App in den Ordner Verfallen verschoben. Hier 
werden alle Vorgänge angezeigt, die die Frist überschritten haben und automatisch geschlossen 
wurden.

Um Vorgänge mit einer Deadline besser hervorzuheben, werden diese in der Task Management Web 
App farblich gekennzeichnet:

: Die Fälligkeit des Vorgangs wurde überschritten und der Vorgang wurde automatisch 
geschlossen und in den Ordner Verfallen verschoben.

: Der Vorgang ist noch am selben Tag fällig.
: Die Fälligkeitsdauer zur Abarbeitung des Vorgangs ist > 24 Stunden. 
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4.4.6 Aufgaben in der Task Management Web App bearbeiten
Für Vorgänge, die einem Prozessbeteiligten zugewiesen wurden, gibt es verschiedene 
Bearbeitungsmöglichkeiten. Diese werden im Folgenden näher erläutert.

4.4.6.1 Vorgang bearbeiten

Nach dem Einloggen in der Task Management Web App werden zunächst alle offenen Vorgänge in 
einer Übersicht angezeigt. Durch Auswählen eines Vorgangs in der Vorgangsliste werden dessen 
Details über mehrere Registerkarten angezeigt.
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2.
3.

•
•
•
•
•
•

1.
2.
3.

1.

Um einen Vorgang zu bearbeiten, gehen Sie wie folgt vor:

Den zu bearbeitenden Vorgang in der Vorgangsliste der Übersichtsseite (Ordner Offen) 
auswählen.
Bearbeiten klicken.
Gewünschte Bearbeitungsmöglichkeit wählen:

Freigeben: Vorgang freigeben
Ablehnen: Vorgang ablehnen 
Herunterladen: Dokument herunterladen 
Hochladen: Dokument hochladen und vorhandenes Dokument ersetzen
Dokument löschen: Dokument löschen
Neues Dokument: Neues Dokument hochladen

4.4.6.2 Vorgang freigeben

Um einen Vorgang freizugeben, gehen Sie wie folgt vor:

Gewünschten Vorgang in der Vorgangsliste der Übersichtsseite (Ordner Offen) auswählen.
Bearbeiten klicken, um die Bearbeitungssicht zu öffnen.
Freigeben klicken.
Der Vorgang wird nun in den Ordner Erledigt verschoben.

4.4.6.3 Vorgang ablehnen

Um einen Vorgang abzulehnen, gehen Sie wie folgt vor:

Gewünschten Vorgang in der Vorgangsliste der Übersichtsseite (Ordner Offen) auswählen.
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1.
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3.
•
•

Ablehnen klicken.

Der Vorgang wird an den Vorgangsbesitzer (Owner) zurückgesendet.

4.4.6.4 Vorgang weiterleiten

Um einen Vorgang weiterzuleiten, gehen Sie wie folgt vor:

Gewünschten Vorgang in der Vorgangsliste der Übersichtsseite (Ordner Offen) auswählen.
Weiterleiten klicken.
Folgender Dialog wird geöffnet:

Zuweisungsart angeben:
Persönlich: Der Vorgang wird an einen einzelnen Benutzer weitergeleitet
Team: Der Vorgang wird an eine Gruppe weitergeleitet

Alternativ lässt sich der Vorgang auch in der Bearbeitungssicht ablehnen. Hierzu 
zunächst Bearbeiten und anschließend Ablehnen klicken.


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4.

5.
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Weiter klicken.
Folgender Dialog wird geöffnet:

Details zur Weiterleitung angeben:
Unter Zuweisung den entsprechenden Benutzer oder die Gruppe
Unter Fälligkeitsdatum bei Bedarf die Fälligkeit des Vorgangs
Dazu die Checkbox aktivieren und ein Datum sowie eine Uhrzeit wählen. Mit   die 
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1.

Angaben bestätigen.

Bei Bedarf einen Kommentar angeben.
Weiterleiten klicken.
Der Vorgang wurde an den angegebenen Benutzer bzw. an die angegebene Gruppe 
weitergeleitet. 

4.4.6.5 Vorgang und auf Wiedervorlage setzen

Um einen Vorgang auf Wiedervorlage zu setzen, gehen Sie wie folgt vor:

Gewünschten Vorgang in der Vorgangsliste der Übersichtsseite (Ordner Offen) auswählen.
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2.

3.
4.
5.

1.

2.

Wiedervorlage klicken.
Folgender Dialog wird geöffnet:

Gewünschtes Datum sowie eine Uhrzeit angeben. Mit   die Angaben bestätigen.
Bei Bedarf einen Kommentar angeben.
OK klicken.
Der Vorgang wird nun in den Ordner Wiedervorlage verschoben. 

4.4.6.6 Dokumente anzeigen und bearbeiten

Um die angehängten Dokumente zu einem Vorgang zu bearbeiten, gehen Sie wie folgt vor:

Den zu bearbeitenden Vorgang in der Vorgangsliste der Übersichtsseite (Ordner Offen) 
auswählen.

Bearbeiten klicken.

Wenn sich der Vorgang bereits in Bearbeitung befindet, den entsprechenden Vorgang 
im Ordner In Bearbeitung auswählen. 


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3.

•
•

•

Innerhalb der Vorgangsdetails die Registerkarte Dokumente öffnen.

Die verschiedenen Bearbeitungsoptionen werden nun als Buttons angezeigt:
Mit Herunterladen das Dokument herunterladen. 
Mit Hochladen ein neues Dokument aus dem Dateisystem hochladen und das 
vorhandene Dokument ersetzen.
Mit Dokument löschen das Dokument unwiderruflich löschen.

Das Löschen eines Dokumentes kann nicht mehr rückgängig gemacht werden. 
Löschen Sie Dokumente nur wenn Sie sicher sind, dass Sie sie nicht mehr 
benötigen. 


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• Mit Neues Dokument ein neues Dokument hochladen. Dazu im Dialog Neues Dokument
einen Title angeben und mit Hochladen ein Dokument aus dem Dateisystem auswählen.
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5 Scheduler
Die Scheduler-Oberfläche bietet einen Überblick über sämtliche Prozesse, für die eine zeitgesteuerte 
Ausführung definiert wurde. Zudem bietet die Oberfläche auch die Möglichkeit, neue zeitgesteuerte 
Ausführungen zu konfigurieren sowie bereits bestehende Konfigurationen zu bearbeiten oder zu 
löschen.

Bei der Definition von Schedules wird zwischen folgenden Ausführungsoptionen unterschieden:

Serverstart: Ausführung eines Prozesses beim Serverstart
CRON: Ausführung eines Prozesses nach bestimmten Cron-Mustern

Die wichtigsten Funktionen des Schedulers sind:

Übersicht der bestehenden Schedules
Erstellen/Bearbeiten von beliebig vielen Ausführungspunkten und -intervallen pro Prozess

5.1 Scheduler erstellen

In der Repository Navigator Sicht ein Projekt rechtsklicken.
Im Kontextmenü New> Schedule wählen.

Der Scheduler wird erstellt und geöffnet.

5.2 Prozesse zeitgesteuert ausführen
Bei der zeitgesteuerten Ausführung von X4-Prozessen können folgende Ausführungsoptionen 
unterschieden werden:

Ausführung eines Prozesses beim Serverstart

•
•

Der Scheduler kann nur in BPM- und ESB-Projekten erstellt werden.
In einem Projekt kann nur ein Scheduler erstellt werden.



Weitere Informationen finden Sie im Abschnitt
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2.

3.

Ausführung eines Prozesses nach bestimmten Cron-Mustern

Mit Cron-Muster können Sie Prozesse an bestimmten Tagen zu bestimmten Uhrzeiten ausführen, z. B. 
jeden Freitag, um 12 Uhr.

5.2.1 Neue zeitgesteuerte Ausführung anlegen
Um eine zeitgesteuerte Ausführung anzulegen, gehen Sie wie folgt vor:

Im Scheduler .schedule die gewünschte Ausführungsoption klicken.
Cron, um Prozesse nach bestimmten Cron-Mustern auszuführen.
Startup, um Prozesse beim Serverstart auszuführen.

Gewünschte Konfiguration vornehmen.

Speichern klicken, um die Ausführung zu speichern.

5.2.2 Serverstart
Neue Konfigurationen für Ausführungen beim Serverstart können über die Schaltfläche 
Startup angelegt werden. Dabei stehen eine Reihe von Optionen und Parameter zur Verfügung. Diese 
werden im Folgenden näher erläutert.

Optionen

Name Frei wählbarer Name für die Ausführung
Process Pfad zum Prozess in der X4DB

Beispiel: Processes/Activities/Processes/Process.wrf

Browse... klicken, um einen Prozess zu wählen.

Active Aktiviert den Scheduler

Start date Setzt den Startzeitpunkt des Schedulers im Format jjjj-mm-tt 
hh:mm:ss

Beispiel: 2021-06-01 13:00:00

Für die Konfigurationsmöglichkeiten der verschiedenen Ausführungstypen, siehe:

Die Dokumentation der ReST-Schnittstelle finden Sie unter http://localhost:8080/X4/X4Api/.

•

•

Der Prozess muss sich im selben Projekt wie der 
Scheduler befinden.
Der Prozess darf kein Unterprozess eines weiteren 
Prozesses sein.



http://localhost:8080/X4/X4Api/
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End date Setzt den Endzeitpunkt des Schedulers im Format jjjj-mm-tt 
hh:mm:ss

Beispiel: 2022-08-01 23:00:00

 Der Endzeitpunkt muss in der Zukunft liegen.

Parameter 

Im Bereich Parameter können Sie beliebig viele Parameter zur Ausführkonfiguration definieren.

Zeile hinzufügen

Zeile löschen

Key Name des Parameters (beliebige Zeichenkette, idealerweise NCName)
Value Optionaler Parameterwert

5.2.3 Cron
Neue Konfigurationen für Ausführungen beim Serverstart können über die Schaltfläche 
Cron angelegt werden. Dabei stehen eine Reihe von Optionen und Parameter zur Verfügung. Diese 
werden im Folgenden näher erläutert.

Optionen

Name Frei wählbarer Name für die Ausführung
Process Pfad zum Prozess in der X4DB

Beispiel: Processes/Activities/Processes/Process.wrf

Browse... klicken oder einen Prozess per Drag & Drop in das Feld 
ziehen, um einen Prozess zu wählen.

Active Aktiviert den Scheduler

•

•

Der Prozess muss sich im selben Projekt wie der 
Scheduler befinden.
Der Prozess darf kein Unterprozess eines weiteren 
Prozesses sein.


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Generate Cron Expression Erzeugt einen Cron-Ausdruck

Mögliche Werte:

Minutes
Hourly
Daily
Weekly
Monthly
Yearly

Parameter 

Im Bereich Parameter können Sie beliebig viele Parameter zur Ausführkonfiguration definieren.

Zeile hinzufügen

Zeile löschen

Key Name des Parameters (beliebige Zeichenkette, idealerweise NCName)
Value Optionaler Parameterwert

In der Registerkarte Source können Sie den Cron-Ausdruck 
manuell editieren.

Das Generieren eines Cron-Ausdrucks ist nicht möglich, wenn 
der Cron-Ausdruck manuell editiert wurde.


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6 Profiling
In einer Profiling-Datei (.profiling) können Sie festlegen, ob Prozesse innerhalb Ihres Projekts zur 
Laufzeit protokolliert werden sollen. In der Profiling-Datei können Sie dabei genau definieren, welche 
Prozesse von der Protokollierung erfasst oder ausgeschlossen werden.

Die Profiling-Datei muss nur angelegt werden, wenn sie bestimmte Prozesse von der Protokollierung 
ausschließen wollen. 

6.1 Profiling-Datei erstellen

Klicken Sie in der Sicht Projects mit der rechten Maustaste auf ein Projekt.
Wählen Sie im Kontextmenü New> Profiling.
Die Profiling-Konfigurationsdatei wird erstellt und geöffnet.

6.2 Profiling konfigurieren
Das Wurzelelement der Profiling-Datei ist <Profiling>. Das Element kann einzelne Prozesse des 
Projekts enthalten, die von einer Protokollierung explizit erfasst oder ausgeschlossen werden sollen.

Das <Profiling>-Element kann folgendes Attribut besitzen:

Attribut Beschreibung
active Legt fest, ob die Protokollierung von Prozessen aktiviert oder 

deaktiviert ist.

Mögliche Werte:

true: Die Protokollierung der Prozesse ist aktiviert. (Standard)

false: Die Protokollierung der Prozesse ist deaktiviert.

Das <Profiling>-Element enthält das Kind-Element <Processes>, das folgendes Attribut enthalten 
kann:

In einem Projekt kann nur eine .profiling-Datei erstellt werden.
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Attribut Beschreibung
filterType Legt fest, ob die hinterlegten Prozesse von der Protokollierung 

erfasst oder ausgenommen werden sollen.

Mögliche Werte:

include: Die hinterlegten Prozesse werden von der 
Protokollierung explizit erfasst.

exclude: Die hinterlegten Prozesse werden von der 
Protokollierung explizit ausgeschlossen.

Das <Processes>-Element kann <Process>-Kindelemente enthalten, sofern ein oder mehrere 
Prozesse explizit von der Protokollierung erfasst oder ausgenommen werden sollen.

Das Process-Element enthält folgendes Attribut:

Attribut Beschreibung
path Erforderlich. Enthält den Pfad zum Technical Process, der erfasst 

oder ausgeschlossen werden soll.

Mögliche Werte: Repository-Pfad zu einem Technical Process (z.B. 
Processes/Process.wrf)

6.3 Beispiel einer Profiling-Konfigurationsdatei
Im nachfolgenden Beispiel werden die Technical Processes Prozess_B.wrf und Process_C.wrf von 
der Protokollierung ausgeschlossen.

<?xml version="1.0" encoding="UTF-8" standalone="yes"?>
<Profiling>
    <Processes filterType="exclude">
        <Process path="Processes/Process_B.wrf"/>
        <Process path="Processes/Process_C.wrf"/>
    </Processes>
</Profiling>
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